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Note!
Before using this information and the products it supports, be sure to read the general information under “Notices” on
page 79.

This edition applies to IBM softcopy collections produced on or after September 2013 containing BookManager
Books built for viewing with the IBM BookManager READ products or IBM Softcopy Reader, and containing PDFs
built for viewing with Adobe Reader or Adobe Acrobat.

This book is available in online format on many of the softcopy collections distributed by the IBM Corporation and
from the IBM Publications Center on the World Wide Web (http://www.ibm.com/shop/publications/order). The
filename of the PDF file is also AB0IN022. This book is also available as INSTALL.PDF (printable file) and
INSTALL.HTM (for Web browsers) in the root directory of many of the IBM softcopy collections.
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How to send your comments to IBM

We appreciate your input on this publication. Feel free to comment on the clarity,
accuracy, and completeness of the information or give us any other feedback that
you might have.

Use one of the following methods to send us your comments:
1. Send an e-mail to mhvrcfs@us.ibm.com
2. Visit the Contact z/OS® web page at http://www.ibm.com/systems/z/os/zos/

webqs.html
3. Mail the comments to the following address:

IBM® Corporation
Department H6MA, Building 707
2455 South Road
Poughkeepsie, NY 12601-5400
U.S.A.

4. Fax the comments to us as follows:
From the United States and Canada: 1+845+432-9405
From all other countries: Your international access code +1+845+432-9405

Include the following information:
v Your name and address
v Your e-mail address
v Your telephone or fax number
v The publication title and order number:

Installing, Managing, and Using the Online Library
GC31-8311-47

v The topic and page number related to your comment
v The text of your comment

When you send comments to IBM, you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate without incurring any
obligation to you.

IBM or any other organizations will only use the personal information that you
supply to contact you about the issues that you submit to IBM.

If you have a technical problem
Do not use the feedback methods listed above. Instead, do one of the following:
v Contact your IBM service representative.
v Contact IBM technical support.
v Visit the IBM support Web page at http://www.ibm.com/systems/support/z/
v Visit the IBM mainframes support Web page at http://www.ibm.com/systems/

z/os/zos/support/

© Copyright IBM Corp. 1996, 2013 vii
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What's New

This section summarizes the changes made to this book.

Streamlined Packaging, Improved Access to Softcopy

September 2013
Starting in September 2013, Version 1.5.1 of the IBM Advanced Linguistic Search
Plug-in for Adobe ships with the softcopy tools on these softcopy collections, and
it can be installed using the softcopy tools installation program. This release is a
service upgrade for Version 1.5 of the plug-in, and supports Version 10 and 11 of
Adobe Reader and Adobe Acrobat. See “IBM Advanced Linguistic Search Plug-in
for Adobe” on page 25.

September 2012
Starting in September 2012, Version 1.5 of the IBM Advanced Linguistic Search
Plug-in for Adobe ships on the disc that includes the softcopy tools, and it can be
installed using the softcopy tools installation program. This version of the plug-in
supports Version 10 and 11 of Adobe Reader and Adobe Acrobat, and also has a
redesigned end user interface. See “IBM Advanced Linguistic Search Plug-in for
Adobe” on page 25.

March 2007
Starting in March 2007, the IBM Advanced Linguistic Search Plug-in for Adobe
ships on the disc that includes the softcopy tools, and it can be installed using the
softcopy tools installation program. See “IBM Advanced Linguistic Search Plug-in
for Adobe” on page 25.

September 2006
Requirements and information about the softcopy tools installation program have
been updated. See Chapter 4, “Program for Installing Softcopy Tools,” on page 19.

June 2004
Starting with IBM Softcopy Reader V3.4 and the June 2004 collections, users
without Windows Administrator authority can both install and run IBM Softcopy
Reader. The autorun preferences tool was updated to support this change. As a
result, there are now two sets of autorun preferences: one set for collections
starting in June 2004, and a separate set for collections from March 2004 and
earlier. You will need to specify new autorun preferences for the June 2004
collections, and you might need to respecify preferences for previous collections. It
depends on the level of collection you are using and the level of SCR that is
installed. (There are no changes if you use a collection from before June 2004 with
a level of SCR before 3.4.)

August 2003
The program for setting autorun preferences has been updated for IBM Softcopy
Reader 3.0 (or later), which supports extended shelves (XKS files) for PDFs.
Extended shelves enable users to access groups of PDFs through the Shelf
Organizer in Softcopy Reader.

© Copyright IBM Corp. 1996, 2013 ix
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See Chapter 7, “Setting Autorun Preferences for Collection Discs,” on page 55 for
more information.

June 2003
The program for setting autorun preferences has been:
v Updated to support the latest level of IBM Softcopy Reader (which was

repackaged to eliminate the prerequisite for the Java Runtime Environment on
the client machine)

v Recoded to comply with accessibility standards
v Renamed from SETUP.EXE to AUTORUN.EXE

See Chapter 7, “Setting Autorun Preferences for Collection Discs,” on page 55 for
more information.

December 2002
Information about copying the interface to the softcopy collection index has been
updated. For details, see Chapter 8, “Using the Softcopy Collection Index with a
Softcopy Repository (Windows Users Only),” on page 57.

June 2002
Starting in June 2002, collections containing both BookManager and PDF files
include an additional index for just the PDF files in the collection. The index is
available in both HTML and text formats (PDFINDEX.HTM and PDFINDEX.TXT)
in the root directory of the discs containing the softcopy files.

Information about copying interfaces from softcopy collections has been added.
v For information about the interface and executables for installing softcopy tools,

see “Installing Tools from a Network Drive” on page 24.
v For information about the interface to the softcopy collection index, see

Chapter 8, “Using the Softcopy Collection Index with a Softcopy Repository
(Windows Users Only),” on page 57.

Netscape is no longer shipped on softcopy collections. Internet Explorer 4.0 or later
is recommended to take advantage of all the functions provided in the HTML
interface to the softcopy collection index.

March 2002
Starting in March 2002, you can set autorun preferences for the programs to run
when a collection disc is inserted in your CD-ROM drive. For example, you can
choose to automatically start Softcopy Reader, the softcopy index for the entire
collection, or the softcopy index for a single disc when you insert a disc containing
softcopy files. Or, you can choose not to have anything start automatically. See
Chapter 7, “Setting Autorun Preferences for Collection Discs,” on page 55 for more
information.

To provide more options for accessing softcopy, multi-disc collections include
single-disc softcopy indexes for each disc in the collection, as well as a softcopy
index for the entire collection.
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September 2000
Starting in September 2000, many IBM softcopy collections include a new program
to simplify installation of softcopy tools and improve access to the softcopy
collection index files included on the collections. Here are the highlights of these
redesigned collections:
v Instead of hardcopy collection indexes (booklets), softcopy versions are provided

in the root directory of each disc. The softcopy collection index is automatically
displayed when you insert a disc containing softcopy publications.

v Instead of a hardcopy version of this manual (Installing, Managing, and Using the
Online Library), softcopy versions are provided in the root directory of each disc.

v All the softcopy tools are on a separate tools disc, instead of on each disc. For a
single-disc library or collection, the tools are on the same disc as the softcopy
publications.

v A new program helps you install or update softcopy tools.
The new program for installing softcopy tools runs only on Windows 95 (or
later), or on Windows NT 4.0 (or later).
Users of other operating systems can still manually install or update the tools on
the tools disc and directly view the softcopy versions of the collection index and
this installation book.
See Chapter 4, “Program for Installing Softcopy Tools,” on page 19 for details.

IBM Softcopy Reader and IBM Library Readers
This section provides information about IBM Softcopy Reader and IBM Library
Readers.

May 2012
For the May 2012 Collections, the installation package for IBM Softcopy Reader
V4.0 has been reworked in a way that enables the Book Reader component to
provide better formatting of table text, and other content, when Bookmanager
objects are launched by file association. The load and runtime performance for the
Book Reader and Shelf Organizer components has been improved.

April 2012
IBM Softcopy Reader V4.0 is available starting with the April 2012 Collections, and
provides better data path management for Windows 7 client systems

September 2011
IBM Softcopy Reader V3.9 can now be installed on a personal computer with
Windows 7 (32 or 64-bit). Support for Windows 2000 is withdrawn.

September 2008
IBM Softcopy Reader can now be installed on a personal computer with Windows
Vista (with a minimum of Service Pack 1 installed) or Red Hat Linux 9.0.

September 2006
Starting with IBM Softcopy Reader V3.6, users can now search both BOOK and
PDF files in extended shelves. See “Starting Book Reader and Shelf Organizer” on
page 36.
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November 2004
IBM Softcopy Reader can now search the BOOK files in an extended shelf. See
“Starting Book Reader and Shelf Organizer” on page 36.

September 2004
IBM Softcopy Reader for Linux is now shipped in the ilrjava directory along with
IBM Softcopy Reader for Windows. Softcopy Reader for Linux is currently not
supported by the program for installing softcopy tools or by the autorun
preferences program, both of which run only under Windows. For more
information, see Chapter 5, “Installing IBM Softcopy Reader,” on page 27.

June 2004
Starting with IBM Softcopy Reader V3.4, users without Windows Administrator
authority can both install and run IBM Softcopy Reader (see Chapter 5, “Installing
IBM Softcopy Reader,” on page 27).

December 2003
Changes were made to the chapter on installing Softcopy Reader (see Chapter 5,
“Installing IBM Softcopy Reader,” on page 27).

October 2003
Starting in October 2003, Softcopy Reader for Windows is supported only on
Windows™ 2000 and Windows XP.

August 2003
Starting in August 2003, a new release (3.0) of the Softcopy Reader for Windows is
being shipped on softcopy collections. This release supports extended shelves (XKS
files) for PDFs. Extended shelves enable users to access groups of PDFs through
the Shelf Organizer in Softcopy Reader.

Softcopy Reader's Bookshelf Organizer has been renamed to "Shelf Organizer," in
recognition of the capabilities of the new extended shelf (XKS file) format. The
shelf organizer can now launch the user's choice of PDF file readers (for example,
Adobe Reader). The Shelf Organizer can also create and modify extended shelves.

Initially, extended shelves include only PDF publications. Additional publication
formats are expected to be added to the extended shelf format in the future.

For more information, see Chapter 5, “Installing IBM Softcopy Reader,” on page 27.

March 2003
Starting in March 2003, a new release (2.4.0) of the Softcopy Reader for Windows is
being shipped on softcopy collections. This release has been repackaged using a
special tool to link the Java Runtime functions along with the Softcopy Reader
application code, building it into a Windows executable instead of a jar file. In
addition to eliminating the prerequisite for the Java Runtime Environment on the
client machine, this change has significantly improved runtime performance.

Information about installing Softcopy Reader has been updated. For details, see
Chapter 5, “Installing IBM Softcopy Reader,” on page 27.
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December 2002
Information about installing Softcopy Reader has been updated. For details, see
Chapter 5, “Installing IBM Softcopy Reader,” on page 27.

March 2001
v Starting in March 2001, the IBM Library Readers for Windows, OS/2, and DOS

are not being shipped on IBM softcopy collections and are no longer supported.
Instead, only the IBM Softcopy Reader is included on the collections.
The IBM Library Readers will continue to be available on an as-is basis from the
IBM BookManager Web site for those users who choose to continue using them.
For more information about BookManager products, including the latest news,
visit http://www.ibm.com/support/entry/portal/Overview/Software/
Other_Software/BookManager_Product_Family/ (see Featured links).

IBM Softcopy Librarian
This section provides information about IBM Softcopy Librarian.

April 2012
IBM Softcopy Librarian V4.6 is available starting with the April 2012 Collections,
and provides better data path management for Windows 7 client systems.

September 2011
Support for Windows 2000 is withdrawn.

April 2010
IBM Softcopy Librarian V4.4 can now be installed on a personal computer with
Microsoft Windows 7.

February 2009
IBM Softcopy Librarian V4.3 can now be installed on a personal computer with
Windows Vista (with a minimum of Service Pack 1 installed) IBM Softcopy
Librarian V4.3 can now be started from an icon installed on the Windows desktop

November 2004
Instructions for managing single documents using Softcopy Librarian were
incorrect and have been removed.

September 2004
Instructions for managing single documents using Softcopy Librarian have been
added.

December 2003
Changes were made to the chapter on installing Softcopy Librarian (see Chapter 6,
“Introducing the Softcopy Librarian,” on page 43).

October 2003
Starting in October 2003, Softcopy Librarian is supported only on Windows™ 2000
and Windows XP.
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August 2003
Starting in August 2003, a new release (4.2) of Softcopy Librarian supports
downloading and management of PDFs via extended shelves (XKS files).

This release has been repackaged using a special tool to link the Java Runtime
functions along with the Softcopy Librarian application code, building it into a
Windows executable instead of a jar file. In addition to eliminating the prerequisite
for the Java Runtime Environment on the client machine, this change has
significantly improved runtime performance.

For more information, see Chapter 6, “Introducing the Softcopy Librarian,” on page
43.

December 2002
Information about Softcopy Librarian has been updated. For details, see Chapter 6,
“Introducing the Softcopy Librarian,” on page 43.

June 2002
Starting in June 2002, Softcopy Librarian (SCL) Version 3 is no longer included on
softcopy collections. Only SCL Version 4 is included. Support for SCL Version 3
will be discontinued after September 30, 2002.

If you have been using SCL Version 3, use SCL Version 4 instead.

September 2001
The Softcopy Receiver Tool (SCRT) is no longer supported. It is being shipped for
the last time on the September and October 2001 softcopy collections. You should
start using the Softcopy Librarian (SCL) instead.

SCL for OS/2 is no longer supported and is provided on an as-is basis. The
product code is available for downloading from:
ftp://ftp.software.ibm.com/ps/products/ibmreader/tools/ebrscl2.exe

June 2001
The Java version of the Softcopy Librarian, IBM Softcopy Librarian V4.0 for
Windows 95 and NT, is now available on IBM softcopy collections and can also be
downloaded from this IBM Web site:
http://publib.boulder.ibm.com/epubs/df/ebrsclwj.exe

For details, see Chapter 6, “Introducing the Softcopy Librarian,” on page 43.

Tools No Longer Supported on IBM Softcopy Collections
As of September 2001, the Softcopy Receiver Tool (SCRT) is no longer supported. It
was shipped for the last time on the September and October 2001 softcopy
collections. You should start using the Softcopy Librarian (SCL) instead.

As of December 1, 1999, IBM has discontinued support for a number of tools that
used to be included on IBM softcopy collections. These include:
v Online Message Facility (OMF) and associated message parsing template (MPT)

files
v Optical Media Attach (OMA)
v SCRT/VM and SCRT/MVS
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v Upload utility

Information about these tools has been deleted from this book. The tools continue
to be available on an “as-is” basis from this FTP server:
ftp://ftp.software.ibm.com/ps/products/ibmreader/tools/

General Changes and Corrections
In addition to these changes, various technical and editorial corrections have been
made.
v In the September 2013 edition and later, since softcopy collections are now only

available in downloadable ZIP files, all references to data on physical media
such as DVDs and CD-ROMs should be considered to be part of a downloadable
ZIP file.

v In the September 2013 edition and later, although there are numerous references
to BookManager Books, the actual availability of the BookManager format on
these softcopy collections is extremely limited due to the sunsetting of the
BookManager format starting with z/OS V2R1.

v In the September 2008 edition, the mailing address for readers' comments has
been updated.

v In the March 2007 edition, the mailing address for readers' comments has been
updated.

v In the September 2006 edition, the ordering information for softcopy collections
as features of z/OS has been updated.

v In the July 2006 edition, several World Wide Web addresses have been updated
or shortened.

v In the July 2006 edition, the IBM Advanced Linguistic Search Plug-in for Adobe
(ALSPI) has been added as optional software.

v In the April 2006 edition, the e-mail address for directly contacting BookManager
Product Support to report problems with using the Softcopy Reader or Softcopy
Librarian has been changed to bookmgr@us.ibm.com.

v In the April 2006 edition, the hardware requirements for IBM Softcopy Reader
and the optional software have been updated.

v In the September 2005 edition, the e-mail address for directly contacting
BookManager Product Support to report problems with using the Softcopy
Reader or Softcopy Librarian has been changed to bkmgrsup@au1.ibm.com.

v In the September 2005 edition, references to OS/390® as an operating system,
server, or host have been removed. As of September 2005, OS/390 is no longer
in service.

v The Publication Notification System (PNS) is no longer available. PNS had sent
users electronic notifications of updated publications based on information in the
users’ profiles.

v In the March 2004 edition, references to "BookManager BookServer" have been
changed to "Library Server" where appropriate.
– Starting with z/OS V1R5 and z/OS.e V1R5, the BookManager BookServer

component of these platforms is replaced by Library Server.
– Starting in March 2004, the IBM BookManager BookServer for World Wide

Web licensed programs for Linux, AIX®, and Windows are replaced by the
Library Server for Multi Platform licensed programs for Linux, AIX, and
Windows.

The Library Server is a specialized World Wide Web server that lets information
providers make softcopy libraries available on the Internet and intranet. Library
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Server is the next generation of IBM BookManager web-based softcopy
technology based on the IBM BookManager BookServer product. Via the
traditional BookServer Library administrative interface, the Library Server
administrator may define a complete softcopy library for use by Library Server.
The Library Server administrator can set up a softcopy library in numerous
ways, and with any or all of the following items:
– Books: IBM BookManager softcopy documents
– PDFs: Adobe Acrobat PDF (Portable Document Format) documents
– Shelves: groups of books and/or PDFs
– Bookcases: groups of shelves
– LibraryCenters: your own customized view of a Library Server Bookcase
With Library Server, the traditional IBM BookServer user interface, which
provides access to all the bookcases and shelves defined in the BookServer
Library, is still available. As before, this interface is available in both framed and
unframed views, the latter of which is the preferred interface for vision-impaired
users. Library Server extends the functionality of BookServer, and has a new end
user interface based on one or more LibraryCenters. A LibraryCenter is a
customizable template-based view of a bookcase, which also provides access via
the traditional BookServer Library interface.

v In the October 2003 edition, references to "Adobe Acrobat Reader" have been
changed to the more general term "Adobe Reader."

v In the March 2003 edition, information about cross-book links in PDFs was
added. For details, see Chapter 3, “PDF Files on IBM Softcopy Collections,” on
page 15.

v In the June 2001 edition, all references to MVS as an operating system, server, or
host have been removed. As of March 30, 2001, the last releases of MVS as an
operating system went out of service worldwide.

xvi Installing, Managing, and Using the Online Library
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Chapter 1. What Is the IBM Online Library?

The “IBM Online Library” contains IBM publications and product books in
softcopy format, organized into collections and packaged on CD-ROMs or DVDs.
Originally, the softcopy collections contained only books available in BookManager
format. Now, collections also contain books available in other formats, such as
Portable Data Format (PDF) and HTML.

All the BookManager books in these softcopy collections can be viewed and
searched electronically, without changing them, on workstations and portable
laptop PCs (running Windows), host systems (running z/OS, z/VM®, VM, or
CICS®), and the AS/400® System. The same book can be viewed at your
workstation or terminal using any of the following methods:
v The IBM Softcopy Reader, which is provided at no charge with the library on

the softcopy collections
v The IBM BookManager READ component of z/OS
v The IBM BookManager READ licensed program for VM
v The Library Server component of z/OS V1R5 or later
v The IBM BookManager BookServer component of z/OS V1R4 or earlier
v The Library Server for Multi Platform licensed programs for Linux, AIX, and

Windows
v AS/400 InfoSeeker, which is provided as a part of the Operating System/400® in

Version 3 and through, but not beyond, Version 4 Release 3

Some of the PDFs in these collections can be searched via the IBM Advanced
Linguistic Search Plug-in for Adobe, which is available for the Windows platform.
Indexed extended shelves of PDFs can also be searched by Softcopy Reader and
the Library Server element of z/OS V1R7 or higher.

Think of the IBM Online Library as you would think of the public library in your
community. A public library houses large numbers of books organized into a
variety of collections by subject. Each collection occupies one or more bookshelves.
The bookshelves contain the books. The public library has a librarian and tools to
help you discover what is available, and find what you want. The IBM Online
Library, like your community library, also contains large numbers of publications
and product books organized into collections. But, the IBM Online Library is not a
big building or a large room; it's little packages of CD-ROMs and DVDs. It's not on
long rows of shelves and stacks of books; it's online. It's not up the street or down
the hall; it's right under your fingertips.

What's in the IBM Online Library?
The Online Library is a variety of softcopy collections that are organized to meet
specific information needs, usually for a specific IBM product or operating
platform. In addition to books, some of the collections also contain online
presentations, interactive demonstrations, and actual products.
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Collections Containing Product Libraries for a Specific
Platform

These collections contain all the product libraries related to a specific IBM
operating platform. They are useful to anyone who must administer or maintain an
entire system or maintain a large online library for others to use.
v z/OS V1Rx and Software Products DVD, SK3T-4271
v z/VM DVD, SK5T-7054
v z/VSE DVD, SK3T-8348
v AS/400 V2R3, SK2T-8250
v AS/400 V3, SK2T-2171
v AS/400 V3R6, SK2T-2839
v AS/400 V3R7, SK2T-8290
v AS/400 V4, SK3T-2027

For example, the z/OS V1Rx and Software Products DVD contains all the available
libraries for z/OS elements and features, plus software products that run on z/OS,
regardless of the type of product.

Collections Containing Product Libraries for a Specific
Function

These collections contain product libraries that are functionally related regardless
of their operating system. They are useful to anyone who must specialize in a
particular computing activity such as administering a network, developing
applications, or maintaining a data base.
v Decision Support Systems, SK2T-0138
v Printing and Publishing, SK2T-2921
v Retail Store Solutions, SK2T-0331
v Transaction Processing and Data DVD, SK3T-6996

For example, the Transaction Processing and Data Collection contains libraries for
CICS, IMS™, DB2®, and other IBM transaction processing and database products.

Collections Containing Books for a Specific Subject or Task
These collections contain individual books from a variety of product libraries and
other sets of books that are related to specific subjects or tasks. They are useful to
anyone who has a specific task to perform such as integrating products,
performing security administration, or learning about system architecture.
v z/OS Security Server RACF® Collection, SK3T-4272 (discontinued)
v IBM iSeries® 400® Redbooks® Collection, SK2T-2849
v IBM eServer zSeries® Redbooks Collection, SK3T-7876
v IBM Redbooks DB2 Information Management Collection, SK2T-8038
v IBM Redbooks Application and Integration Middleware Collection, SK2T-8037
v Best of APPC, APPN, and CPI-C, SK2T-2013
v IBM Networking Redbooks Collection, SK2T-6022
v Messages and Codes Collection, SK2T-2068 (discontinued)

For example, the z/OS Security Server RACF Collection contains books from any
z/OS product library that includes RACF information, regardless of the type of
product.

The Relationship between the Collections
Some product libraries appear in more than one collection. The GDDM® library is
in the z/OS, VSE, and z/VM platform collections because it is a product that runs
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on z/OS, z/VSE, and z/VM. It is also in the Transaction Processing and Data
Collection because it is used by IBM transaction processing and database products.

Even though product libraries and individual books appear in more than one
collection, all the collections that are issued at the same time contain libraries and
books that are at the same level.

Regular Updates to the Collections
Most IBM softcopy collections are revised regularly. Each update can include new
products, new versions of existing products, updates to the existing libraries,
enhancements to the Softcopy Reader program used for viewing the online
libraries, and enhancements to the Softcopy Librarian program used for managing
updates to online libraries.

Many collections are revised to coincide with the release of specific products.
Sometimes books or product libraries are updated sooner than the next planned
updates to the collections.
v Increasingly, products are delivering the latest updates to their books on the

Internet as soon as they are available. Sometimes these updates are provided for
the product's general availability (GA). Sometimes they are provided to get
important information to users as quickly as possible.

v Individual product libraries are sometimes provided on product-specific
CD-ROMs or on DVDs with some of the new products you order. This ensures
that the latest books for a product physically accompany that product when it is
released for general availability (GA).

Internet updates and updated product libraries are generally included in the next
update of the IBM softcopy collections to which they apply.

Directories and Files on IBM Softcopy Collections
The following table shows the directories and files common to IBM softcopy
collections. Some collections have additional directories and files for features
unique to that particular collection. Softcopy collections that include multiple discs
might have the following files on only one disc in the collection.

Information Files
SCINDEX.xxx Softcopy collection index, which lists and links to all the softcopy books on a

collection
PDFINDEX.xxx PDF index, which lists and links to all the PDF files on a collection that contains

both BookManager and PDF files
DISC.HTM Disc-specific, single-disc softcopy index, which lists and links to all the softcopy

books on the disc that contains this file
INSTALL.xxx Various formats of Installing, Managing, and Using the Online Library
BOOKENG.AGR Terms for using softcopy collections
PLALRENG.AGR License agreement for IBM Softcopy Reader

Readers (directories)
ILRJAVA Program for installing IBM Softcopy Reader for Windows

Program for installing IBM Softcopy Reader for Linux

Softcopy Libraries (directories)
BOOKS The books and shelf search indexes on the disc
SHELVES The bookshelves and extended shelves on the disc
PDF The PDF files on the disc

Uploading and File Management Programs (directories)
SCL Program for installing IBM Softcopy Librarian
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Utilities
SCTOOLS.EXE Program for installing and updating softcopy tools; related files in AUTOHTML

directory
AUTORUN.EXE Program for setting or changing autorun preferences for the programs to run

when a collection disc is inserted

Optional Directories and Files (might not be in your softcopy collection)
Security management and performance tools
Multimedia product demos and overviews
Other file formats for books

Using IBM Softcopy Collections in Your Business
You can set up an IBM softcopy collection on your Windows workstation for
yourself or you can share it with your coworkers co-workers. You can distribute
the collection throughout your organization to individual workstations or to a few
conveniently located, walk-up-and-use “information kiosks.” You can centralize it
on your z/OS, z/VM, or VM host or on a LAN server and share it within your
entire enterprise. IBM softcopy collections have been designed so that you can
distribute them as widely as you need inside your enterprise.

With IBM softcopy collections, you can receive your documentation electronically,
and use the Softcopy Librarian to set up an electronic document repository to
manage, update, and distribute online books throughout your business. In
addition, you can use the IBM BookManager technology to build and view your
own documentation, thus creating a consistent, seamless information environment
for your customers.

Direct Access at the Workstation
If you have a CD-ROM or DVD drive directly attached to your Windows
workstation, you can install the IBM Softcopy Reader for viewing the books and
either:
v Use the CD-ROM or DVD as the storage device, and insert it whenever you

need to view the books.
v Download libraries or individual books from the CD-ROM or DVD to your

workstation hard drive. This can improve your access time.
v Do both: move the most frequently used libraries or individual books to your

hard drive and use the remainder on the CD-ROM or DVD.

Network Access to a LAN Server
If you have a network of workstations attached to a Windows LAN server, you
can:
v Use the CD-ROM or DVD as the storage device to hold all of the libraries and

let your customers select the online books to open and view when they want
them. Multi-disc CD-ROM drives are available so you can make a number of
CD-ROMs available to your network customers.

v Download libraries or individual books from the CD-ROM or DVD to your
server hard drive. This can improve your access time.

v Download libraries or individual books and reader programs from the CD-ROM
or DVD to user workstations on the network.

v Do a combination: move the most frequently used libraries or individual books
to your server hard drive or user workstations and use the remainder on the
CD-ROM or DVD.
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Host-System Access for Sharing and Centralizing Softcopy
Collections

You can use a workstation to copy libraries from the CD-ROM or DVD to your
host system to share and centralize online libraries for a group of users. For
example, you can:
v Upload the books from a workstation to a z/OS host and view them from an

attached terminal or workstation with the IBM BookManager READ component
of z/OS.

v Upload the books from a workstation to a z/VM or VM host and view them
from an attached terminal or workstation with the IBM BookManager
READ/VM licensed program. This licensed program is not provided on IBM
softcopy collections.

v Upload the books and the reader installation package to a z/OS, z/VM, or VM
host, download them, and install them on a workstation that doesn't have a
CD-ROM or DVD drive.

Internet or Intranet Access to BookManager Files via Library
Server (or BookServer)

If you have a z/OS, z/OS.e, Windows, AIX, or Linux-based server, you can upload
the books and bookshelves to the server and use Library Server or BookServer to
serve the BookManager files to Web browsers for viewing over the Internet or an
intranet. Library Server (or BookServer) converts the BookManager files to HTML
dynamically, as you read them.

BookServer provides limited support for PDF files when a companion file in
BookManager format is present. When such a PDF is selected, BookServer launches
Adobe Reader or Adobe Acrobat for that PDF file.

Library Server provides full support for PDF files. PDFs are rendered by launching
Adobe Reader or Adobe Acrobat. On the z/OS platform, Library Server can search
PDFs that have been enabled with the IBM Advanced Linguistic Search Index by
interacting with the IBM Advanced Linguistic Search Plug-in for Adobe, the
following versions of which are available:
v Version 1.5, and 1.5.1 which run on a Windows client having Adobe Reader (or

Adobe Acrobat) 10 or 11
v Version 1.4.1, which runs on a Windows client having Adobe Reader (or Adobe

Acrobat) 9
v Version 1.4, which runs on a Windows client having Adobe Reader (or Adobe

Acrobat) 8
v Version 1.3, which runs on a Windows client having Adobe Reader (or Adobe

Acrobat ) 7

Internet or Intranet Access to PDF Files
If you have a z/OS, OS/2, Windows, or AIX server, you can upload PDF files from
an IBM softcopy collection to the server and use a Web server to serve the PDF
files to Web browsers for viewing over the Internet or an Intranet. You can use FTP
to send the PDFs to the server as binary, VB 4096 data sets. On a z/OS server,
users can print the PDFs via InfoPrint Server.

AS/400 System Access
You can use your workstation to copy libraries from the CD-ROM or DVD to your
AS/400 system, and then:
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v Create shared folders of books from IBM softcopy collections on an AS/400, and
view them using OS/400® InfoSeeker

v View the books directly from the CD-ROM or DVD using OS/400 InfoSeeker

Note: OS/400 support of InfoSeeker exists through, but not beyond, Version 4
Release 3 of the base operating system.

Browser Access to a Softcopy Repository
To improve user access to online books copied from a softcopy collection, you
might want to provide a browser interface by copying the softcopy collection index
that was provided on that collection. For more information, see Chapter 8, “Using
the Softcopy Collection Index with a Softcopy Repository (Windows Users Only),”
on page 57.

What Should You Do Next?
For more information about the BookManager family of products, visit the World
Wide Web at http://www.ibm.com/support/entry/portal/Overview/Software/
Other_Software/BookManager_Product_Family/ (see Featured Links).

If you are ready to start building your online libraries using IBM softcopy
collections, see “How You Can Order IBM Softcopy Collections” on page 9.

How IBM Softcopy Collections Are Made Available
IBM softcopy collections are made available, like hardcopy books, in a variety of
ways: as a feature of a product or by direct purchase of single copies.

In the United States
Collections are made available in the following ways:
v Nonbillable (Entitled Basic) Product Feature Codes

If you are a license holder for certain IBM products, such as z/OS, you can
receive some collections as basic, nonbillable features of those products. Basic,
nonbillable features are entitled and are shipped automatically. You do not need
to specify any feature codes when you order the product in order to receive
them. For example, the z/OS V1Rx Collection is shipped automatically with
z/OS V1Rx.

v Nonbillable (Entitled Optional) Product Feature Codes

If you are a license holder for an IBM product that runs on AS/400, z/VM, VM,
or z/VSE, you can receive some collections as optional, nonbillable features of
those products or prerequisite products. Optional, nonbillable features are
entitled, but they are not shipped unless you specify the appropriate feature
code when you order the product.
If you did not specify the optional, nonbillable feature code when you ordered
the product, you can still get these entitled collections by ordering them later.
Call IBM at 1+800+879-2755. There is no charge for these optional, nonbillable
features. If you do not have a license for any of the products that entitle a
collection, you are not entitled to an optional, no-fee collection.

v Billable (Non-entitled) Product Feature Codes

Some collections are available as optional, billable features of products. Optional,
billable features are not entitled, and they are not shipped unless you specify the
appropriate feature code when you order the product. If you did not specify the
optional billable feature code when you ordered the product, you can order
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them later. You are billed when the collection is shipped initially. If you do not
have a license for any of the products that feature the collection you want, you
cannot order that collection as an optional, billable feature.
Special discounts might be available. Currently, discount subscriptions are
available for the following collections:
– IBM eServer zSeries Redbooks Collection, through a feature code on z/OS
– The z/OS Software Products Collection, through a feature code on z/OS
– The z/OS and Software Products DVD Collection, through a feature code on

z/OS
v Single-Copy Purchase

You can also purchase single copies of a collection with no updates. You can
order single copies in the same way that you order any printed book from IBM.
You only need to know the order number of the collection you want. You are
billed for each collection you order. For more information, see “How You Can
Order IBM Softcopy Collections.”

In Other Countries
Contact your IBM representative.

How You Can Order IBM Softcopy Collections
You can order IBM softcopy collections using the IBM ordering systems normally
used to order hardcopy publications or software features. Specify the appropriate
order number of the publication or collection, or the z/OS program number and
title of the collection for the software feature, where applicable. Ordering options
include the Internet, toll-free numbers, and your IBM representative.

In the United States and Other Countries
To order collections for a specific country, do one of the following:
v Go to the IBM Publication Center on the World Wide Web at

http://www.ibm.com/shop/publications/order

and select a country, then select Search for publications, and type the
publications number. Payment options are via customer number or credit card.
You can also read and download online publications in various formats free of
charge at this Web site.

v Contact an IBM representative or call the local IBM office and ask for the
literature department.

In the United States Only
In addition to the ordering options listed above, use any of the following methods:
v Call the IBM toll-free number 1+800+879-2755 and select the Publications option

(press 1). If you are using a rotary phone, wait for assistance.
v Send an order form to IBM as follows:

– By FAX at 1+800+445+9269
– By direct mail to:

IBM Corporation
P.O. Box 29570
Raleigh, NC 27626-0570
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To order a collection as a feature of z/OS, contact your IBM representative or call
IBM Direct at 1+800+426-2255 and mention priority code LE001. Indicate that you
are ordering a z/OS product feature. Specify the z/OS program number and the
name of the collection to which you want to subscribe.

For More Information
You can obtain more information about the collections that are available, product
feature codes, and ordering collections.
v If you have specific questions about IBM softcopy collections or need more

information about the collections, contact IBM by any of the following methods:
– FAX: International Access Code+1+845+432+9405
– Internet: mhvrcfs@us.ibm.com
– World Wide Web: http://www.ibm.com/zseries/softcopy/feedback.html
– Your IBM representative

v For news about updated collections, visit http://www.ibm.com/zseries/
softcopy/whatsnew.html.

v To view the contents (catalogs) of the collections, visit and select the specific
collection name for the desired edition, then select Collection Index in the
desired format.
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Chapter 2. Introducing the IBM Reader Programs

The following table lists the readers available, by operating system, for viewing
online books in BookManager format. This includes online books on IBM softcopy
collections, and also online books that you can build yourself using BookManager
BUILD programs or that you receive from companies other than IBM that do not
provide IBM reader programs.

IBM Softcopy Reader, listed in the second column, is included at no charge on IBM
softcopy collections.

Note: Softcopy Reader 3.0 (or later) can also be used to access groups of PDFs via
extended shelves (XKS files). However, reading the PDF files still requires a
separate program, such as Adobe Reader. Starting with Softcopy Reader
V3.6, you can search indexed extended shelves of PDFs. One of the
following versions of the IBM Advanced Linguistic Search Plug-in for Adobe
can be used to automatically search individual PDFs that have been enabled
with the Advanced Linguistic Search Index and selected from the Softcopy
Reader shelf search results:
v Version 1.5 and 1.5.1, which run on a Windows client having Adobe

Reader (or Adobe Acrobat) 10 or 11
v Version 1.4.1, which runs on a Windows client having Adobe Reader (or

Adobe Acrobat) 9
v Version 1.4, which runs on a Windows client having Adobe Reader (or

Adobe Acrobat) 8
v Version 1.3, which runs on a Windows client having Adobe Reader (or

Adobe Acrobat ) 7

The BookManager READ products, listed in the third column of the table, are
available from IBM for a fee. The program number for ordering them is listed in
the table.

For more information about BookManager products, including the latest news, see
this Web site: http://www.ibm.com/support/entry/portal/Overview/Software/
Other_Software/BookManager_Product_Family/ (see Featured links).

Notes about the IBM Library Readers:

1. Starting in March 2001, the IBM Library Readers for Windows, OS/2, and DOS
are not being shipped on IBM softcopy collections and are no longer supported.
Instead, only the IBM Softcopy Reader is included on the collections.

2. If your current IBM Library Reader is from before March 1999, make sure to
install IBM Softcopy Reader. The IBM Library Readers from before March 1999
could view only the stamped books on IBM Online Library CD-ROMs. Because
the books on IBM softcopy collections are no longer stamped, pre-1999 IBM
Library Readers cannot open those books.
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Operating System Free reader programs (included on
this softcopy collection)

IBM BookManager Readers
(available from IBM)

Program Number for IBM
BookManager Readers

Windows Softcopy Reader

Linux Softcopy Reader

Windows See Note 4

OS/2 See Note 4

DOS See Note 4

AIX See Note 4

z/OS BookManager READ See Note 1

z/VM READ/VM 1.3 5684-062

VM READ/VM 1.3 5684-062

CICS READ/GT See Note 2

OS/400 InfoSeeker See Note 3

Note:

1. BookManager READ is shipped as a component of z/OS.

2. The READ/GT reader is available from GT Software.

3. InfoSeeker is shipped as part of AS/400. OS/400 supports InfoSeeker through, but not beyond, Version 4 Release
3 of the base operating system.

4. The following IBM BookManager products are no longer supported: READ/2, READ for Windows, READ/DOS,
READ/6000, IBM Library Reader for Windows, IBM Library Reader/2, IBM Library Reader/DOS.

Downloading IBM Readers from the Internet
You can see if you are using the latest level of IBM Softcopy Reader by looking at
the “IBM Softcopy Reader” page at http://www.ibm.com/support/docview.wss?rs=4
&uid=swg27018849 on the IBM Web site and comparing the level of your reader
with the available level listed at the bottom of that page.

If you do not have the latest level, you can download it from that link on the
above page.

The latest version of IBM Softcopy Reader for Windows is also available
electronically by following these instructions.

1. FTP to ps.software.ibm.com as user "anonymous".

2. Go to: /ps/products/bookmanager/tools.

3. Refer to the SWINREAD.TXT file in that directory.

4. Get the ILRJAVA.EXE file (in binary mode) from that directory.

Planning to Install IBM Softcopy Reader
You must install IBM Softcopy Reader (provided on IBM softcopy collections) in
order to view and search the online books and set up an online book library on
your workstation. The IBM softcopy collections contain installation programs to
help you do this.
v To use the installation program for softcopy tools (which identifies whether you

have the latest level of IBM Softcopy Reader), see Chapter 4, “Program for
Installing Softcopy Tools,” on page 19. This applies only to Softcopy Reader for
Windows.
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v To install Softcopy Reader directly, see Chapter 5, “Installing IBM Softcopy
Reader,” on page 27.

Code Page Requirement
Make sure you are using code page 850 (the multilingual code page) with the
IBM softcopy collections. If you are not using code page 850, BookManager
may not run correctly.

Considerations for InfoSeeker
If you already have InfoSeeker installed, you do not need to install an IBM
Library Reader program, but you should:

1. Run the Library Reader/DOS installation program to update your
configuration files to point the BookManager READ program to the devices
containing books and bookshelves.

2. Update the BookManager environment variable in your CONFIG.SYS file to
specify the path to the book and bookshelves by adding the pointers to the
BOOKMGR statement in the CONFIG.SYS file. For example, if you want to
point to the F drive, enter: f:\books;f:\shelves in the BOOKMGR statement.

Transferring Files to CICS Using READ/GT
If READ/GT (available from GT Software) is installed in your CICS host
environment, you can transfer BookManager files from your CD-ROM to your
mainframe CICS system and use them with READ/GT.

If you have access to GT Software's ASSIST/GT online referencing product, you
can reference BookManager files from help windows displayed at the top of CICS
application screens.
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Chapter 3. PDF Files on IBM Softcopy Collections

Some IBM softcopy collections include printable files in Portable Document Format
(PDF) in addition to or instead of books in BookManager form.

You can use an Adobe Reader to view and print the PDF files. For tips on printing
PDF files, see “Printing a PDF File” on page 63.
v Starting in September 2000, some IBM softcopy collections include a program to

simplify installation of softcopy tools and improve access to the softcopy
collection index. Adobe Reader is one of the tools you can install from these
collections. Starting in September 2013, the version shipped on these collections
is Adobe 11. If this reader is not appropriate for your operating system or if you
need information on installing and using Adobe Reader, see the Adobe Web site
at:
http://www.adobe.com

v Softcopy Reader 3.0 (or later) can be used to access groups of PDFs via extended
shelves (XKS files). However, reading the PDF files still requires a separate
program, such as Adobe Reader.

v Softcopy Reader 3.6 (or later) can be used to display extended shelves, or search
indexed extended shelves, of PDFs. When a PDF is selected from a shelf search
hit list, after Softcopy Reader launches Adobe Reader (or Acrobat), the IBM
Advanced Linguistic Search Plug-in for Adobe automatically produces a ranked
list of highlighted search hits within the selected PDF.

v The IBM Advanced Linguistic Search Plug-in for Adobe is one of the tools you
can install from these collections, and may be used to perform advanced
linguistic searching on any PDF that has been enabled with the IBM Advanced
Linguistic Search Index being viewed in Adobe Reader (or Acrobat), whether or
not Adobe Reader (or Acrobat) had been launched from Softcopy Reader or
Library Server.

Sometimes PDF documents on a collection contain cross-book links. In order for
these links to work, the PDFs must be in the same directory. If the documents are
on CD-ROMs or DVDs, the documents must also be on the same disc.

PDFs link to each other by file name, and IBM changes a document's file name
whenever the document is updated. Thus, a link from an unchanged PDF might
not connect to a new edition of a target document, because the new edition has a
new file name. However, a link from an unchanged PDF will still connect to its
original target document. Therefore, if you maintain your own PDF repository, IBM
recommends that you keep multiple levels of PDFs together in the same directory,
to minimize unresolved links. By contrast, BookManager documents link to each
other by their base order numbers, which stay the same from release to release, so
an unchanged BOOK file can usually link successfully to an updated target BOOK
file.
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Part 2. Installing Softcopy Tools
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Chapter 4. Program for Installing Softcopy Tools

Starting in September 2000, many IBM softcopy collections include a
Windows-based program to simplify installation of softcopy tools and improve
access to the softcopy collection index files included on the collections. Here are
the highlights of these redesigned collections:
v Instead of hardcopy collection indexes (booklets), softcopy versions are provided

in the root directory of each disc.
v Instead of a hardcopy version of this manual (Installing, Managing, and Using the

Online Library), softcopy versions are provided in the root directory of each disc.
v For a multi-disc CD-ROM library or collection, all the softcopy tools are on a

separate tools disc, instead of on each disc.
For a single-disc CD-ROM library or collection, the tools are on the same disc as
the softcopy publications.
For all DVD collections, the tools are on each DVD in the collection.

v An additional program (SCTOOLS.EXE) helps you install or update softcopy
tools.

This chapter introduces the program for installing softcopy tools.

Who can use this install program?
Windows XP is recommended.

Users of other operating systems can still manually install or update the tools
on the collection, and view the softcopy versions of the collection index and
this installation book directly.

Overview
The program for installing softcopy tools (SCTOOLS.EXE) helps you:
v Learn about the IBM softcopy collection: IBM Softcopy Reader (SCR), IBM

Advanced Linguistic Search Plug-in (ALSPI) for Adobe, and IBM Softcopy
Librarian (SCL).

v Install or update these softcopy tools as well as Adobe Reader.
The install program checks the level of the tools (if any) installed on your
computer and gives you the option of installing any tools you do not have and
updating any tools not at the latest level.

Note: Although Softcopy Reader for Linux is included on collections starting in
September 2004, it is not supported by this Windows-based program for
installing softcopy tools. To install Softcopy Reader for Linux, see
ilrjava\linux\slinread.txt on the collection disc that includes the softcopy
tools.
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System Requirements

Software Requirements
v Supported platform: Windows XP is recommended
v Software for viewing, searching, or printing documents on the softcopy

collection:
– BookManager files: IBM Softcopy Reader

The program for installing softcopy tools checks whether you have the IBM
Softcopy Reader installed. If not, you can choose whether to install the level
of this reader from the tools disc.

Note: The latest level of IBM Softcopy Reader is indicated at the bottom of
the “IBM Softcopy Reader” page:

http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018849.
– HTML files: A Web browser with Java Script 1.0 enabled. Internet Explorer

5.0 or later is recommended to take advantage of all the functions provided in
the HTML interface to the softcopy collection index.

Note: By default, certain options of the install program display information in
HTML format. So, to view this information from the install program,
you should have a browser installed.

– PDF files: Adobe Reader (at least Version 3 for viewing and printing, and at
least Version 7 for advanced linguistic searching using the IBM Advanced
Linguistic Search Plug-in for Adobe)
The install program checks whether you have Adobe Reader installed. If not,
you can choose whether to install Adobe Reader from the disc that includes
the tools.

– Text files: Any workstation file viewer or browser
v Software required for softcopy tools on the tools disc

– IBM Softcopy Reader: See “Software and Hardware Requirements” on page
28.

– IBM Softcopy Librarian: See “Software and Hardware Requirements” on page
46.

– Adobe Reader: See “Adobe Reader” on page 24.
– IBM Advanced Linguistic Search Plug-in for Adobe: See “IBM Advanced

Linguistic Search Plug-in for Adobe” on page 25.

Hardware Requirements
v Any personal computer capable of running Windows XP with an Intel Pentium

II (or higher) or compatible processor
v Display device supported by Windows XP with VGA or better resolution;

minimum recommended resolution is 800 by 600 pixels
v Any pointing device supported by Windows XP
v A CD-ROM or DVD reader accessed as a Windows drive
v Additional RAM or hard disk space as required by the softcopy tools on the

tools disc (see the chapters on those tools for details)
v Additional hardware requirements for the softcopy tools on the tools disc

– IBM Softcopy Reader: See “Software and Hardware Requirements” on page
28.
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– IBM Softcopy Librarian: See “Software and Hardware Requirements” on page
46.

– Adobe Reader: See “Adobe Reader” on page 24.
– IBM Advanced Linguistic Search Plug-in for Adobe: See “IBM Advanced

Linguistic Search Plug-in for Adobe” on page 25.

Optional Hardware
v A Windows-supported printer

Getting Started
1. Insert the tools disc into your CD-ROM or DVD drive.

v For a multi-disc CD-ROM library or collection, the install program starts
automatically if autorun is enabled on your computer.
The install program does not start automatically if autorun is disabled on
your computer. In this case, run SCTOOLS.EXE (in the root directory) to start
the install program.

v For a single-disc CD-ROM library or collection or a DVD collection, the
install program does not start automatically. To start the install program, run
SCTOOLS.EXE (in the root directory).

Note: If autorun is enabled on your computer, you can access the files on the
tools disc without automatically launching any programs or files and
without disabling autorun. Go to My Computer or Windows Explorer,
right-click on the icon for your CD-ROM or DVD drive, then click
Explore.

2. If desired, read the online documentation provided with the install program
(SCREADME.TXT for the install program, or the online version of Installing,
Managing, and Using the Online Library).

3. Using the install program, install the desired softcopy tools (See “Using the
Program for Installing Softcopy Tools” for details.)

4. Exit the install program.
5. Insert a data disc to view the softcopy collection index, which lists and links to

the publications in the collection.

Using the Program for Installing Softcopy Tools
When the install program starts, you see a list of the tasks the program can help
you with:
v Read about using softcopy and tools
v Install or update softcopy tools

You can also get help for the install program, as well as send feedback on the
program or on the IBM softcopy collection.

The following sections describe the tasks in more detail.

Reading about Using Softcopy and Tools
To learn more about the install program, about softcopy in general and the tools
that help you use and manage softcopy, or about the specific publications on the
softcopy collection in your CD-ROM or DVD drive, click Read about using
softcopy and tools. Then choose either of these online documents:
v SCREADME.TXT for the install program
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v Installing, Managing, and Using the Online Library (the book you are now reading).
By default, you see the HTML format of this book, but you can choose to see it
in any of these formats:
– HTML: For viewing with a Web browser.
– BookManager: For viewing and searching with the IBM Softcopy Reader. This

format provides the best search function of all the formats. It can also be used
to print selected sections of the book, but the PDF format is recommended for
printing large sections or an entire book.

Note: When you select the BookManager format, you might see a warning
message prompting you to select whether to open the file or save it to
disk. Select Open it. Also, to view BookManager files without being
interrupted by this warning, uncheck the box Always ask before
opening this type of file.

– PDF: For viewing, searching, and printing with Adobe Reader or Adobe
Acrobat. From this format you can print high-quality output that looks very
similar to printed books received from IBM.

– Text: For viewing with a workstation file viewer, such as Notepad.

From this window, you can also choose to view the softcopy collection index for
the collection currently in your CD-ROM or DVD drive. This index is available as
an HTML file, and also in the additional formats provided for Installing, Managing,
and Using the Online Library, if available. From the HTML format, you can search
for keywords in the file and open the softcopy files for the libraries and
publications listed, provided that the disc containing the files is in your CD-ROM
or DVD drive.

In addition, you can see Web links (URLs) that are helpful for this IBM softcopy
collection. Plus, you can go directly to the Send feedback option to provide
comments or ask questions about the IBM softcopy collection itself or about the
program for installing softcopy tools.

Note: The install program displays the files for this option through a Web browser.
If you do not yet have a Web browser installed, you can:
v Select the Install or update softcopy tools option to install one.
v Use a workstation file viewer to view the following text files. These files

are in the root directory of the tools disc:
– SCINDEX.TXT: softcopy collection index

Installing or Updating Softcopy Tools
To install the tools for viewing and managing the softcopy on this collection, or to
be sure you have the latest level of these tools, click Install or update softcopy
tools.

1. The install program checks which softcopy tools currently exist on your
computer and recommends what should be installed or updated to view and
manage the collection.
You can deselect (uncheck) what you do not want to install or update.
These are the tools that you can install or update:
v IBM Softcopy Reader (recommended reader). For more information, see

Chapter 5, “Installing IBM Softcopy Reader,” on page 27.
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v IBM Softcopy Librarian (used for updating local repositories). If you plan to
copy softcopy publications to a repository, select V4 (Java) of Softcopy
Librarian. For more information, see “Installing the Softcopy Librarian” on
page 50.

v Adobe Reader. For more information, see “Adobe Reader” on page 24.
v IBM Advanced Linguistic Search Plug-in for Adobe (used to perform

advanced linguistic searching of PDFs). For more information, see “IBM
Advanced Linguistic Search Plug-in for Adobe” on page 25.

2. After you make your selections, the program installs the selected items.
You might need to respond to prompts as the individual tools are being
installed. The README files for some of the softcopy tools contain additional
information to help you install these tools. User's guides are also available after
you have installed certain tools.
v IBM Softcopy Reader: ILRJAVA\WINDOWS\SWINREAD.TXT on tools disc and

Start→Programs→IBM Softcopy Reader→User's Guide
v IBM Softcopy Librarian: Start→Programs→IBM Softcopy Librarian→User's

Guide
3. If you installed IBM Softcopy Reader, make sure to shut down and restart your

browser. This ensures that the browser will invoke IBM Softcopy Reader to
open BookManager files.

4. Once installation is complete, you can choose to see the softcopy collection
index for the library or collection currently in your CD-ROM or DVD drive.

The Softcopy Collection Index
When you view the softcopy collection index from the SCTOOLS.EXE interface,
you see the HTML format by default, but you can choose to see it in any of these
formats, if they are available:
v HTML: For viewing with a Web browser. This format is only the catalog (index)

portion of the complete booklet for the library or collection. The HTML format
contains links that enable you to open the softcopy files for the libraries and
manuals listed. Internet Explorer 5.0 or later is recommended to take advantage
of all the functions provided for viewing the HTML version of the softcopy
collection index.

Note: In order for the links to open the softcopy files, the preferences for your
browser must point to the IBM reader program you installed for viewing
BookManager books (extension .BOO), bookshelves (extension .BKS), and
extended shelves (extension .XKS, for use with Softcopy Reader 3.0 or
later).

If you install a copy of IBM Softcopy Reader from September 2000 (V2.3.1)
or later and agree to have Softcopy Reader be the default reader for
BookManager files, the installation process automatically updates the
preferences for you. Otherwise, you cannot set up browser preferences for
Softcopy Reader.

v BookManager: For viewing and searching with the IBM Softcopy Reader. This
format is the complete collection booklet. The BookManager format provides the
best search function of all the formats. It can also be used to print selected
sections of the book, but the PDF format is recommended for printing large
sections or an entire book.

Note: When you select the BookManager format, you might see a warning
message prompting you to select whether to open the file or save it to
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disk. Select Open it. Also, to view BookManager files without being
interrupted by this warning, uncheck the box Always ask before opening
this type of file.

v PDF: For viewing, searching, and printing with Adobe Reader or Adobe
Acrobat. This format is the complete collection booklet. From the PDF format
you can print high-quality output that looks very similar to printed books
received from IBM.

v Text: For viewing with a workstation file viewer, such as Notepad. This format
is only the catalog (index) portion of the complete booklet for the library or
collection.

All formats of the softcopy collection index are searchable. For example, you can
look for any text or phrase that appears in the title of a publication or library.

From this window, you can also choose to view Installing, Managing, and Using the
Online Library. This book is available in these formats:
v HTML
v BookManager
v PDF
v Text

In addition, you can see Web links that are helpful for this IBM softcopy collection.
Plus, you can go directly to the Send feedback option to provide comments or ask
questions about the install program or the IBM softcopy collection itself.

Installing Tools from a Network Drive
You might want to provide a group of users with the ability to install one or more
softcopy tools from a network drive. There are several way to do this:
v The simplest way is to copy the desired executables from the collection to the

desired directory on the network drive. For example, to enable users to install
IBM Softcopy Reader, you could copy \ILRJAVA\WINDOWS\ from the \ILRJAVA
directory on the tools disc of the collection to a directory on your network drive.
Users could then run ILRJAVA.EXE from the network drive to install IBM
Softcopy Reader.

v To run the complete SCTOOLS.EXE interface from a network drive, you need to
copy the complete directory structure. All the paths are relative. (The files and
directories listed below are the only ones required for SCTOOLS.EXE to install
tools. The other files and directories on the tools disc provide background
information.)
SCTOOLS.EXE - program for installing softcopy tools

\ADOBE - contains Adobe Reader
\AUTOHTML - contains products.txt
\ILRJAVA - contains IBM Softcopy Reader
\PLUGINS - contains the IBM Advanced Linguistic Search Plug-in for Adobe
\SCL - contains IBM Softcopy Librarian

Note: SCTOOLS.EXE is written as a local application. It cannot run from an HTTP
server and interact with users.

Adobe Reader
To help you view and print PDF files displayed by the program for installing
softcopy tools, the collections and libraries containing that install program also
include a recent level of Adobe Reader.
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v If your computer meets the requirements described in “System Requirements”
on page 20, use the install program to install Adobe Reader.

v Otherwise, go to the ADOBE directory on the tools disc and run the EXE file to
install Adobe Reader.

If the Reader on the tools disc is not appropriate for your operating system, or if
you need information about Adobe Readers, go to the products page at this Web
site:
http://www.adobe.com

IBM Advanced Linguistic Search Plug-in for Adobe
To perform advanced linguistic searching within Adobe Reader (or Acrobat) 10 or
11 for PDFs containing an IBM Advanced Linguistic Search Index, the IBM
Advanced Linguistic Search Plug-in (ALSPI) for Adobe V1.5.1 is included on the
tools disc.
v If your computer meets the requirements described in “System Requirements”

on page 20, use the softcopy tools installation program to install IBM Advanced
Linguistic Search Plug-in for Adobe.

v Otherwise, go to the PLUGINS directory on the tools disc and run the
hclxinst.exe file to install the IBM Advanced Linguistic Search Plug-in for Adobe.

If you wish to install a different version of the IBM Advanced Linguistic Search
Plug-in for Adobe (for example, V1.4.1, for use with Adobe Reader (or Acrobat) 9,
or V1.4, for use with Adobe Reader (or Acrobat) 8), or V1.3, for use with Adobe
Reader (or Acrobat) 7), or if you want more information about the IBM Advanced
Linguistic Search Plug-in for Adobe, see the “IBM Advanced Linguistic Search
Plug-in for Adobe” page at http://www.ibm.com/support/docview.wss?rs=4
&uid=swg27018852. The links for the downloadable releases at the bottom of this
page may also be checked for availability of any upgrades to the IBM Advanced
Linguistic Search Plug-in for Adobe.

When you run the IBM Advanced Linguistic Search Plug-in for Adobe installation
script you will be prompted for the following:
v Acceptance or rejection of the applicable license agreement
v Your customer name and company
v Under which installed instance of Adobe Reader or Adobe Acrobat you wish to

install the plug-in
v Confirmation to proceed

After completing the installation script, you'll be given an opportunity to view the
IBM Advanced Linguistic Search Plug-in for Adobe Readme file.

Note that it is usually desirable to install the latest version of the IBM Advanced
Linguistic Search Plug-in for Adobe. Any version that is later than those available
on these collections is always available via the above referenced web page. If
searching PDFs on this Softcopy Collection Kit results in “Could not locate the
topic in the PDF outline tree” errors, upgrading Adobe Reader (or Acrobat) and
IBM ALSPI to the latest available version should mitigate most of these errors.

Note: Special note regarding Adobe Reader (and Acrobat) 10 and 11: Due to
restrictions imposed within Adobe Reader (and Acrobat) 10 and 11, the IBM
ALSPI icon (magnifying glass) no longer appears in the Adobe Reader (or
Acrobat) 10 or 11 toolbar as part of the IBM ALSPI 1.5 or 1.5.1 installation.

Chapter 4. Program for Installing Softcopy Tools 25

|
|
|
|

|
|
|
|
|
|
|
|
|

|
|
|
|

http://www.adobe.com/
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018852
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018852


The IBM ALSPI function can still be launched from Adobe Reader (and
Acrobat) by clicking the “IBM Advanced Linguistic Search” entry in the Edit
dropdown menu from the Adobe Reader (or Acrobat) 10 or 11 menu bar, or
context menu presented when right-clicking anywhere in the PDF content.
There are some end user based methodologies for achieving IBM ALSPI icon
access within Adobe Reader (and Acrobat) 10 and 11, but only under limited
circumstances, not to be described here.

Note: If a “Failed to load temp diiFile” error occurs when attempting to launch a
PDF having an IBM ALSPI index in Adobe Reader (or Acrobat), it may be
necessary to disable “Protected” view/mode in Adobe Reader (or Acrobat).
Depending on the version of Adobe Reader (or Acrobat) being used, this
setting is usually found under Edit->Preferences->General or
Edit->Preferences->Security(Enhanced) in Adobe Reader (or Acrobat).

Note: If a “DLL was not found” error occurs when attempting to launch IBM
ALSPI, or if Adobe Reader (or Acrobat) crashes after attempting to perform
a search using the IBM ALSPI, the latest available downloadable installation
package for the plug-in should be installed, even if its version number is the
same as the one already installed.
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Chapter 5. Installing IBM Softcopy Reader

IBM Softcopy Reader is made up of two programs: (1) Book Reader, and (2) Shelf
Organizer. It can be installed on a personal computer with Windows XP, Windows
Vista (with a minimum of Service Pack 1 installed), Windows 7 (32 or 64-bit) or
Red Hat Linux 9.0..

Refer to Readme file
Please refer to the Readme file shipped with the IBM Softcopy Reader
(C:\Program Files (x86)\IBM\SCR\swinread.txt on Windows 7 64-bit
machines, or C:\Program Files\IBM\SCR\swinread.txt on all other Windows
machines) for any other specific requirements and to ensure you have the
latest most up-to-date installation instructions.

When you install the Softcopy Reader, the following items will be installed on your
workstation.
v Readme file — contains the latest information on the product and installation

instructions
v IBM Softcopy Reader User's Guide — explains how to use the Softcopy Reader
v Book Reader program — allows you to view and search online books
v Shelf Organizer program — allows you to view, manage, and search online

shelves, and view or search the online books or PDFs they contain.

Note: Starting with the March 2003 IBM Online Library Collection Kits, the
Windows version of the Book Reader and Shelf Organizer programs are
executable in the native Windows environment. You no longer need to have
the Java Runtime environment installed on your Windows machine.

Once the Windows version of IBM Softcopy Reader is installed, you can run the
Book Reader and Shelf Organizer programs by clicking on the icons installed on
the Windows desktop, or by clicking the Start button on the Windows desktop and
selecting the following: Start > Programs > IBM Softcopy Reader

Note: The Book Reader and Shelf Organizer programs may be run from the
command line interface, however when doing so on a Windows 7 64-bit
system, it is important to note that only 32-bit Java is supported. It is the
responsibility of the user to ensure that 64-bit Java is not launched. If 64-bit
Java is inadvertently launched (usually the result of the PATH environment
variable setting) certain dll compatibility errors will prevent the program
from running.

Linux Installations

The Linux version of IBM Softcopy Reader is installed and run via the command
line interface only.

Windows Administrator Authority

New for the Windows version of IBM Softcopy Reader V3.4, is the capability of
users without Windows Administrator authority to both install and run IBM
Softcopy Reader. When installing IBM Softcopy Reader, select the option "to install
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to the current user" for a user specific installation, or select "All Users" to do a
system wide installation (requires Administrator authority).

The Windows version of IBM Softcopy Reader now uses configuration files specific
for each user in the user's Documents and Settings home directory. You will need
access to at least some user writable hard drive space and authority to modify the
user's specific Windows registry hive:
HKEY_CURRENT_USER

Most users have this authority by default. System-wide installations need some
user writable hard drive space and the authority to modify the Windows Registry
hive:
HKEY_LOCAL_MACHINE

This may require you to have Administrator authority.

Software and Hardware Requirements

Refer to Readme file
Please refer to the Readme file shipped with the IBM Softcopy Reader
(C:\Program Files (x86)\IBM\SCR\swinread.txt on Windows 7 64-bit
machines, and C:\Program Files\IBM\SCR\swinread.txt on all other
Windows machines) for the latest information on specific software and
hardware requirements

Required Software

v Operating system — One of the following:
– Microsoft Windows 7 (32 or 64-bit), Windows XP or Windows Vista (with a

minimum of Service Pack 1 installed)
– Red Hat Linux 9.0, with Sun Java Runtime 1.4.1, or higher

Required Hardware

v Any personal computer capable of running Windows 7 (32 or 64-bit), Windows
XP, Windows Vista (with a minimum of Service Pack 1 installed) or Red Hat
Linux 9.0

v Display device supported by Windows 7 (32 or 64-bit), Windows XP, Windows
Vista (with a minimum of Service Pack 1 installed) or Red Hat Linux 9.0 (VGA
or better resolution)

v Any pointing device supported by Windows 7 (32 or 64-bit), Windows XP,
Windows Vista (with a minimum of Service Pack 1 installed) or Red Hat Linux
9.0

v A minimum of 512MB of RAM is recommended (minimum of 1GB of RAM for
Windows Vista)

v Hard-disk drive storage in addition to the storage required by Windows 7 (32 or
64-bit), Windows XP, Windows Vista (with a minimum of Service Pack 1
installed) or Red Hat Linux 9.0:
– IBM Softcopy Reader: 150 MB (a total of 200 MB of free disk space is required

to run the install program.)
v One or more Windows- or Red Hat-supported CD-ROM drives and the

equipment needed to attach them to your workstation
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Optional Software:

v Adobe Reader (or Acrobat) 3 (or later) is required if you plan to view or print
PDF files on Windows. Adobe Reader (or Acrobat) 7 (or later) is required if you
also plan to perform advanced linguistic searching of PDF files on Windows.

v The IBM Advanced Linguistic Search Plug-in for Adobe (ALSPI) is required if
you plan to perform advanced linguistic searching of PDF files that have been
enabled with the Advanced Linguistic Search Index, when launched in Adobe
Reader (or Acrobat) via Softcopy Reader, or otherwise. When the IBM Advanced
Linguistic Search Plug-in for Adobe is installed, a PDF selected from Softcopy
Reader shelf search results is searched automatically. The latest available version
of the plug-in at the time this collection was manufactured has been provided on
the tools disc. For any given client, however, the appropriate ALPSI version to
use depends on the installed version of Adobe Reader (or Acrobat). Specifically:
– Version 1.5 and 1.5.1 run on a Windows client having Adobe Reader (or

Adobe Acrobat) 10 or 11
– Version 1.4.1 runs on a Windows client having Adobe Reader (or Adobe

Acrobat) 9
– Version 1.4 runs on a Windows client having Adobe Reader (or Adobe

Acrobat) 8
– Version 1.3 runs on a Windows client having Adobe Reader (or Adobe

Acrobat ) 7

The latest level of this plug-in is always available for download from the links at
the bottom of the “IBM Advanced Linguistic Search Plug-in for Adobe” page at
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018852

v XPDF is required if you plan to view PDF files on Linux.

Optional Hardware:

v A Windows- or Red Hat-supported printer

Directory Names of Your Books, PDFs, Shelves and Shelf Indexes

During installation of the Windows version, you will be asked to specify the
locations (path names) for books, shelves and shelf indexes on your system. You
can specify paths for books, PDFs, shelves and shelf indexes:
v The hard drive(s) on your system (C:,D:,E:, etc.)
v CD-ROM drive(s) on your system
v External hard drives or CD-ROM drives that you are connected to via a network

(you may have multiple CD-ROM drives that you want to access)
v Other storage devices that can be attached to your system

During installation of the Windows version, you will be asked to specify the drive
letter of your primary CD-ROM drive. The Shelf Organizer can do an auto refresh
when the CD is removed and replaced with another.

Please have this information available when you start the installation of the
Windows version.

Path specification may also be performed after installation, at run time, via the
Edit> User Defined Directories menu selection. For the Linux version of IBM
Softcopy Reader, this is the only way to specify path information.
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Installation Steps
This is the recommended sequence for installing IBM Softcopy Reader:
1. Remove any previous versions of IBM Softcopy Reader, and beta versions of

Softcopy Reader for Java. See “Removing IBM Softcopy Reader From Your
System” on page 38.

2. Install IBM Softcopy Reader. This program can be downloaded from IBM
Online Library Collection kits, and from the IBM BookManager pages on the
IBM Web site (the latest level will be on the IBM Web site).

3. Start and run Book Reader or Shelf Organizer. See “Starting Book Reader and
Shelf Organizer” on page 36.

Installing IBM Softcopy Reader on Windows Platforms
Only Softcopy Reader V3.8, or greater, is supported on Windows Vista.

Only Softcopy Reader V3.9, or greater, is supported on Windows 7 (32 or 64-bit).

Note: Prior to Softcopy Reader V4.0, for certain installations of Windows Vista or
Windows 7 it may be necessary to create a secondary Windows
administrator userid under which to install and run Softcopy Reader.
Specifically, this is required if the primary administrator id being used does
not have its own entry in the c:\users\ directory tree.

These procedures allow you to install IBM Softcopy Reader, which consists of Book
Reader and Shelf Organizer, on your system. The install program can be
downloaded for free from:
v An IBM Online Library Collection Kit CD-ROM
v The links at the bottom of the “IBM Softcopy Reader” page at

http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018849

Specifying Paths to Books, PDFs, Shelves, and Shelf Indexes
You can specify the locations (path names) for books, PDFs, shelves and shelf
indexes on your system that reside on:
v The hard drive(s) on your system (C:,D:,E:, etc.)
v CD-ROM drive(s) on your system
v External hard drives or CD-ROM drives that you are connected to via a network

(you may have multiple CD-ROM drives you want to access)
v Other storage devices that can be attached to your system

For Windows, the path information may be specified when you install the program
and/or at runtime.

Installing from an IBM Online Library Collection Kit CD-ROM
IBM Online Library Collection Kit CD-ROMs contain a copy of the IBM Softcopy
Reader installation program. If the collection is made up of several CDs, refer to
the documentation that came with it to see which CD-ROM contains the
installation program. On most collections it will be on the first CD-ROM of the set.
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Softcopy Tools Installation Program
This section assumes that you are not using the softcopy tools installation
program to install IBM Softcopy Reader. For information about using the
softcopy tools installation program, see Chapter 4, “Program for Installing
Softcopy Tools,” on page 19.

These instructions assume your hard disk is C and your CD-ROM drive is D. If
they are not, substitute the drive letters you are using for the letters shown in the
examples.

1. Start the Windows program.

2. From the IBM Online Library Collection, insert the CD-ROM containing the
Softcopy Reader installation program into the CD-ROM drive on your PC.

3. Click on the Start button.

The Start menu appears.

4. Select the Run option.

The Run window appears.

5. In the Run window, if the following path does not appear:

d:\ilrjava\windows\ilrjava.exe

Then type this path: d:\ilrjava\windows\ilrjava.exe

6. Click on OK.

A window will open with the following message: The InstallShield(R)
Wizard will install the IBM Softcopy Reader on your computer.

7. Click Next and following the instructions on the Installation window.

8. During installation, you will be asked to:

v Specify the location (paths) to books, PDFs, shelves and shelf indexes.
For example: D:\BOOKS;D:\PDF;D:\SHELVES

Note: These must be valid paths; that is, the directories must already exist
in the drives specified.

Multiple CD-ROM drives: If you have more than one CD-ROM drive, you
can add the paths to them.
Hard disk: If you plan to copy files to your hard disk, you can add hard
drive paths as well, after defining the directories on your hard drive. For
example, if your hard disk is C and a second CD-ROM drive is E, the
preceding example would now be:
D:\BOOKS;D:\PDF;D:\SHELVES;C:\BOOKS;C:\PDF; C:\SHELVES;E:\BOOKS;E:\
PDF;E:\SHELVES

v Select the default directory shown in the window to save any notes you
create in the books, or specify your own directory. Make sure the user has
write access to path for the notes directory.

v Specify your Web Browser directory which will be used when opening URL
links with in books.

v You have the option to specify the drive letter(s) for your CD-ROM drive(s).
While optional, specifying the drive letter is recommended, particularly
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when using the IBM Online Library Collection CD-ROMs, so that the Shelf
Organizer knows to refresh its list of Shelves when the CD in the CD-ROM
drive is changed.

v If you already have the IBM Library Reader installed on your system,
specify if you would like to make the IBM Softcopy Reader the default
reader.

9. When the installation is complete, you can start using Book Reader and Shelf
Organizer. You do not have to reboot your system.

Icons for the Book Reader and Shelf Organizer will be placed on your desktop
during installation.

Installing from the IBM BookManager Pages on the IBM Web
Site

You can download the latest level of the IBM Softcopy Reader from the IBM
BookManager pages on the IBM Web site as follows:

1. Start the Windows program.

2. Open your Web browser and go to the “IBM Softcopy Reader” page at
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018849

3. Click on the Download Softcopy Reader for Windows link at the bottom of
the page.

4. Click on the Softcopy Reader for Windows Download link.

5. Select a drive and folder on your system to download the executable
Softcopy Reader installation file (ILRJAVA.EXE), then click Save. The
Softcopy Reader file will be downloaded to this drive and folder on your
system.

6. Click on the windows Start button.

The Start menu should appear.

7. Select the Run option.

The Run window should appear.

8. In the Run window, click on Browse. When the Browse window opens, select
the drive and folder you specified in Step 4 to save the file, then highlight
the ILRJAVA.EXE file and click on Open. The correct path to the
ILRJAVA.EXE file should be displayed in the Run window.

9. Click on OK.

A window will open with the following message: The InstallShield(R)
Wizard will install the IBM Softcopy Reader on your computer.

10. Click Next and following the instructions on the Installation window.

11. During installation, you will be asked to:
v Specify the location (paths) to books, PDFs, shelves and shelf indexes.

For example: D:\BOOKS;D:\PDF;D:\SHELVES

Note: These must be valid paths; that is, the directories must already exist
in the drives specified.

Multiple CD-ROM drives: If you have more than one CD-ROM drive,
you can add the paths to them.
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Hard disk: If you plan to copy files to your hard disk, you can add hard
drive paths as well, after defining the directories on your hard drive. For
example, if your hard disk is C and a second CD-ROM drive is E, the
preceding example would now be:
D:\BOOKS;D:\PDF;D:\SHELVES;C:\BOOKS;C:\PDF;C:\SHELVES;
E:\BOOKS;E:\PDF;E:\SHELVES

v Select the default directory shown in the window to save any notes you
create in the books, or specify your own directory. Make sure the user has
write access to path for the notes directory.

v Specify your Web Browser directory which will be used when opening
URL links with in books.

v You have the option to specify the drive letter(s) for your CD-ROM
drive(s). While optional, specifying the drive letter is recommended,
particularly when using the IBM Online Library Collection CD-ROMs, so
that the Shelf Organizer knows to refresh its list of Shelves when the CD
in the CD-ROM drive is changed.

v If you already have the IBM Library Reader installed on your system,
specify if you would like to make the IBM Softcopy Reader the default
reader.

12. When the installation is complete, you can start using Book Reader and Shelf
Organizer. You do not have to reboot your system.

Icons for the Book Reader and Shelf Organizer will be placed on your desktop
during installation.

The installation program also establishes the necessary file associations with
appropriate content type settings to ensure that Softcopy Reader is launched when
Books or Shelves are selected from the user's desktop, or accessed from a browser.

Installing IBM Softcopy Reader on Red Hat Linux Platforms
These procedures allow you to install IBM Softcopy Reader, which consists of Book
Reader and Shelf Organizer, on your system. The installation file can be
downloaded for free from:
v An IBM Online Library Collection Kit CD-ROM
v The links at the bottom of the “IBM Softcopy Reader” page at

http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018849

Specifying Paths to Books, PDFs, Shelves, and Shelf Indexes
- Linux

You can specify the locations (path names) for books, PDFs, shelves and shelf
indexes on your system that reside on:
v The hard drive mount points on your system
v CD-ROM drive mount points
v External hard drives or CD-ROM drive mount points that you are connected to

via a network (you may have multiple CD-ROM drives you want to access)
v Other storage devices that can be attached to your system

For Linux, the path information can only be specified at run time.
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Installing from an IBM Online Library Collection Kit CD-ROM -
Linux

Starting in September 2004, IBM Online Library Collection Kit CD-ROMs contain a
copy of the IBM Softcopy Reader compressed tar file. If the collection is made up
of several CDs, refer to the documentation that came with it to see which CD-ROM
contains the installation compressed tar file. On most collections it will be on the
first CD-ROM of the set. These instructions assume the product will be installed at
/opt/scr and the CD-ROM mount point is at /mnt/cdrom. If they are not, substitute
the mount points as appropriate.

1. Start Red Hat Linux.

2. Download and install the Sun JRE 1.4.1 or higher.

3. Insert the CD-ROM containing the Softcopy Reader compressed tar file, into
the CD-ROM drive on your PC.

4. Open a terminal console window. In Red Hat Linux, this can be done by
clicking the Run program option from the start menu by typing "konsole".

5. Decide on an installation directory. These steps assume the program will be
installed under /opt/scr. For most Red Hat installations, this will require root
user authority. If you do not have root user authority, select a directory that
you can write to. The following steps (5 and on) assume root user authority.
If you need to switch to root user, do so with the "su" command.

6. From the terminal console, type "cd /opt".

7. Then, type "mkdir scr".

8. Next, type "cd scr".

9. Next, type "tar -zxvf /mnt/cdrom/ilrjava/linux/ilrjava.tgz".

There is limited support for file association under Linux. To do file
association, first edit the hlcb.sh.desktop and hlcs.sh.desktop files found in
the Install directory, changing the path specified under the lines starting with
"Exec=" and "Icon=" to the path specified when untarring the Softcopy
Reader package.

Note: If the Softcopy Reader package is untarred to /opt/scr, this step is not
necessary.

Next, copy both files to a directory location under one of the following
directories depending, on who will be using Softcopy Reader:

Directory: User

/usr/share/applnk-redhat All KDE users

/usr/share/gnome/apps All Gnome users

/etc/X11/applnk All users

~/.kde/share/applnk-redhat Current user's when KDE is
running

~/.gnome/apps Current user when Gnome is
running

Have every user do Steps 10-12.

10. Add "/opt/scr/sys" and the Sun JRE to the user path as appropriate.
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11. Run the Shelf Organizer by typing "hlcs.sh" Add any paths that you may
need later, such as: "/mnt/cdrom" to the list of User Defined Directories. To do
this, select Active Directories> User Defined Directories from the menu bar.
If you intend to view PDF files, select a viewer by selecting Edit>Document
Type Preferences... from the menu bar.

12. When the installation is complete, you can start using Book Reader and Shelf
Organizer. It is not necessary to reboot your system.

Installing from the IBM BookManager Pages on the IBM Web
Site

You can download the latest level of the IBM Softcopy Reader from the IBM
BookManager pages on the IBM Web site as follows:

1. Start the Linux system.

2. Open your Web browser and go to the “IBM Softcopy Reader” page at
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018849

3. Select the Download Softcopy Reader for Linux link at the bottom of the
page.

4. Click on the Softcopy Reader for Linux Download link.

The File Download window will open.

5. Click Save. The Save as... window will open.

6. Select a suitable place on your system to download the .tgz file, then click
Save.
The Softcopy Reader file will be downloaded to this location.

7. Open a terminal console window. In Red Hat Linux, this can be done by
clicking the Run program option, then typing "konsole".
Run the following steps in the terminal console:

8. "mkdir installdirectory", where installdirectory is the directory where the SCR
program will reside.

9. "cd installdirectory".

10. "tar -zxvf place_download_to/ilrjaval.tgz" (where place_download_to is the
directory to which the .tgz file was saved).
There is limited support for file association under Linux. To do file
association, first edit the hlcb.sh.desktop and hlcs.sh.desktop files found in
the Install directory, changing the path specified under the lines starting with
"Exec=" and "Icon=" to the path specified when untarring the Softcopy
Reader package.

Note: If the Softcopy Reader package is untarred to /opt/scr, this step is not
necessary.

Next, copy both files to a directory location under one of the following
directories depending on who will be using Softcopy Reader:

Directory: User

/usr/share/applnk-redhat All KDE users

/usr/share/gnome/apps All Gnome users

/etc/X11/applnk All users
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~/.kde/share/applnk-redhat Current user's when KDE is
running

~/.gnome/apps Current user when Gnome is
running

Have every user do Steps 11-13.

11. Add "/opt/scr/sys" and the Sun JRE to the user path as appropriate.

12. Run the Shelf Organizer by typing "hlcs.sh". Add any paths that you may
need later, such as: "/mnt/cdrom" to the list of User Defined Directories. To do
this, select Active Directories>User Defined Directories from the menu bar.
If you intend to view PDF files, select the viewer by selecting
Edit->Document type Preferences... from the menu bar.

13. When installation is complete, you can start using Book Reader and Shelf
Organizer. It is not necessary to reboot your system.

Running the Programs/Viewing the Documentation
1. To run "Book Reader" choose: Run Program and type "hlcb.sh"

2. To run "Shelf Organizer" choose: Run Program and type "hlcs.sh"

3. To open the User's Guide" (in the Book Reader), choose: Run Program and type
"hlcb.sh", and after the Book Reader is launched, click Help->User's Guide.

Note: You can also open books in the Book Reader from within the Shelf
Organizer.

Starting Book Reader and Shelf Organizer
This section shows you how to start and use Book Reader and Shelf Organizer. The
following table shows when you would use each program.

Functions Book Reader Shelf Organizer

Open a shelf N/A YES

Open a book YES YES

Open a PDF file NO YES

Create a new shelf N/A YES

Search a book YES (single book) YES (multiple books)

Search a PDF file NO YES (using IBM Advanced
Linguistic Search Plug-in for
Adobe within Adobe Reader
or Acrobat)

Search an unindexed
bookshelf

N/A YES

Search an indexed bookshelf N/A YES

Search an unindexed
extended shelf

N/A YES (books only - Quick
Search not permitted)

Search an indexed extended
shelf

N/A YES (PDFs only when using
Quick Search - otherwise,
books only)

Create a note in a book YES N/A

36 Installing, Managing, and Using the Online Library



Use a bookmark YES N/A

Print a topic YES YES (via Adobe Reader for
launched PDFs)

Copy a topic to clipboard YES N/A

Save a topic as HTML YES N/A

Starting Book Reader
Follow these steps to start Book Reader and open a book:

1. Insert the IBM Online Library collection CD into the CD-ROM drive.

Note: If you are using multiple CD-ROM drives, be sure you put all of the
Online Library CDs you plan to use in the drives before starting Book
Reader or Shelf Organizer to open the Online Library.

2. On the Windows Desktop

Start the Book Reader either by double clicking on the Book Reader desktop
icon, or by clicking on the Start button and do the following:
a. Select the Programs option.
b. Select IBM Softcopy Reader.
c. In the Softcopy Reader group, select the icon for Book Reader

The IBM Softcopy Reader window should open.
From a Linux Command prompt

Type hlcb.sh

3. From the Menu Bar click on File, then click on Open.

The Open Book window should open.

4. On the Open book window, in the Look in window click on the down arrow
symbol. You should see a list of drives that are physically on or attached to
your system via a network.

5. From Windows

Click on the drive letter (C:, D:, etc.), then click on the folder containing the
book you want to open. The books contained in the folder will then be listed.
From Linux

Click on the folder you wish to open. The Books contained in the folder will
then be listed. Right click on the book and select the Open With option. Find
the Book Reader program and select it.

6. Highlight the book you want to open by clicking on it, then click on Open.
The book should open.

For instructions on using Softcopy Reader, refer to the Softcopy Reader: User's Guide.
You can access this guide from two places.
v The IBM Online Library Reference Shelf included on most Online Library

collection kit CDs.
v The Softcopy Reader "Book Reader" and "Shelf Organizer" programs. Select

Help, from the Menu Bar, then click on User's Guide.

We recommend using the User's Guide shipped with the Softcopy Reader program
since it will have the most recent updates to the book.
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Starting Shelf Organizer
Follow these steps to start Shelf Organizer, select a shelf, then select and open a
book:

1. Insert the IBM Online Library Collection CD into the CD-ROM drive.

Note: If you are using multiple CD-ROM drives, be sure you put all of the
Online Library Collection CDs you plan to use in the drives before
starting Softcopy Reader or Shelf Organizer to open the Online Library.

2. On the Windows Desktop

Start the Shelf Organizer either by double clicking on the Shelf Organizer
desktop icon, or by clicking on the Start button and do the following:
a. Select the Programs option.
b. Select IBM Softcopy Reader.
c. In the Softcopy Reader group, select the icon for Shelf Organizer.
The IBM Softcopy Reader List of Shelves window should open. The List of
Shelves sub-window shows a list of the shelves you can access. This list of
shelves is from all of the directory paths you specified when installing IBM
Softcopy Reader, and shelves you added to the User Defined Directories for
Books, PDFs, Shelves and Shelf Indexes since installation.
From a Linux command prompt

Type hlcs.sh

3. From the List of Shelves sub-window, highlight the shelf that contains the
book you want to open by clicking on the shelf name.

Notes:

a. The icon to the left of the shelf name you selected will change to show an
open shelf.

b. By clicking on the Name, Date, and Title tabs of the window, you can
change the order of how the shelves are listed:
v Alphabetically: Name and Title tabs (ascending or descending)
v Chronologically: Date tab (ascending or descending) Click once for

ascending and a second time for descending.
The Shelf sub-window will display the name of the Shelf you selected and list
all of the books on that Shelf.

4. From the Shelf sub-window, double-click on a book or PDF. This will open the
Book Reader window or launch Adobe Reader to display the book or PDF
respectively, that you selected.

For instructions on using Softcopy Reader, refer to the Softcopy Reader: User's Guide.
You can access this guide from two places.
v The IBM Online Library Reference Shelf included on most Online Library

collection kit CDs.
v The Softcopy Reader "Book Reader" and "Shelf Organizer" programs. Select

Help, on the Menu Bar, then click on User's Guide.

We recommend using the User's Guide shipped with the Softcopy Reader program
since it will have the most recent updates to the book.

Removing IBM Softcopy Reader From Your System
You can easily remove (uninstall) IBM Softcopy Reader (Book Reader and Shelf
Organizer) from your system.
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Note: If you have created any shelf (*.BKS or *.XKS), or notes (*.NTF) files in the
directory where Softcopy Reader is installed (or its subdirectories) you
should backup up those files to a different location before uninstalling.

Windows Platform Systems
To remove (uninstall) the program:

1. Double-click on My Computer on your Windows Desktop.

The My Computer window should open.

2. Double-click on the Control Panel folder.

The Control Panel window should open.

3. Double-click on Add/Remove Programs.

The Add/Remove Program window should open.

4. Scroll down the list of software and highlight IBM Softcopy Reader by
clicking on it.

5. Click on the Add/Remove button and follow the instructions on the screen.

Linux Platform Systems
To remove (uninstall) the IBM Softcopy Reader program from your Linux platform
system:

1. Change the root user, if necessary.

2. Remove the program files from the installation directory that was specified in
the Installing IBM Softcopy Reader on Red Hat Linux Platforms.

3. Remove program directory from user paths.
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Part 3. Managing BookManager Softcopy
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Chapter 6. Introducing the Softcopy Librarian

This chapter introduces and summarizes what the IBM Softcopy Librarian can do
for you and how to install it.

What the Softcopy Librarian Can Do for You
The IBM Softcopy Librarian V4.2 (and later) provides you with the ability to
manage softcopy shelves and associated publications. Shelves can either be
provided by IBM or built using the IBM BookManager shelf architecture and
BookManager Build for books, or a builder application for other softcopy
publications, such as Adobe Acrobat Distiller for PDFs.

The Softcopy Librarian provides the following capabilities:
v Manages the following types of BookManager files and file types (MVS and

Local Unix)
– BookManager

- Books (BOOK or .BOO files)
- Shelves (BKSHELF or .BKS files)
- Extended Shelves (XKSHELF or .XKS files)
- Shelf indexes (BKINDEX or .BKI files)

– IBM-supplied PDF documents (PDF or .PDF files)
v Active Management, in addition to transferring files, also includes:

– Maintaining a catalog of the contents for each of your repositories
– Comparing what is currently in your repositories with new sources of

shelves, Books, PDFs, and associated publications.
– Providing you with the comparative status of the items in the source in

relation to the contents of your current repositories.
– Updating the catalogs whenever you transfer new shelves, Books, PDFs, and

other publications to your repositories
– Identifying items in your repositories that can be removed because there are

newer versions of these items also in your repositories.
v Set up and maintain repositories using a variety of sources. You can obtain and

transfer shelves and associated publications from:
– CD collections from IBM
– OEM (Original Equipment Manufacturers) CD Collections
– The IBM PUBLIB Web site (over the Internet)
– A local hard disk
– Other Web sites
– Support for PDF files obtained from either the "PUBLIB" Web site, or the IBM

Collection "CD."

Note: In general, using the Internet to obtain shelves and associated publications
from IBM might be slower than using CDs. We recommend that you use
the IBM CD-ROM collections for the normal quarterly refreshes, and use
the Internet only for updating your repositories between quarters with the
latest releases.

v Tracking of new shelves and associated publications
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The Softcopy Librarian keeps a catalog of all the shelves and associated
publications that you send to your repository from any level of a CD, from your
local hard drive, from the IBM PUBLIB Web site, or any other Web site that
supports the Softcopy Librarian. When a new level of a shelf arrives, on a new
CD or downloaded from a Web site, the Softcopy Librarian compares it and its
contents with the catalog and shows you whether it's brand new or whether it's
changed since the last level you received. You now have a way to see, at a
glance, which shelves on a CD or on a supported Web site are currently in your
host repository.

v Support for z/OS Repositories
The Softcopy Librarian supports repositories in sequential data sets. You can use
BookManager READ/MVS to access the Books and shelves on your z/OS host.
All communication with the host is done via FTP.
– Current support is for IBM TCP/IP FTP only.
– BookManager READ/MVS requires service for APAR PQ75262 before, or

when, you upload Extended Shelves (XKS files).
v Support for z/OS Unix System Services Repositories

The Softcopy Librarian supports repositories in either hierarchical file systems or
sequential data sets. You can use Library Server for z/OS V1R5 or later (or
BookManager BookServer for z/OS V1R4 and earlier) to access the Books,
shelves, and other publications on your z/OS host or server. All communication
with the host is done via FTP.
– Current support is for IBM TCP/IP FTP only.

v Support for Unix-like Repositories
The Softcopy Librarian supports repositories on Unix-like servers. You can use
Library Server (or BookManager BookServer) to access the Books, shelves, PDFs,
and other publications on your Unix-like server. All communication with the
host is done via FTP.
– Current support is for IBM TCP/IP FTP only.

v Support for PC/LAN Repositories
The Softcopy Librarian supports repositories on LAN server or local personal
computer hard drives that can be accessed as a drive letter on Windows
systems. The drive must be a valid target for a Copy command. You can use the
BookManager Softcopy Reader to access shelves, Books, PDFs, and other
publications on your LAN server or PC workstation.

v Support for PDF files
The Softcopy Librarian supports Extended Shelves to organize PDF files,
obtained from either the "PUBLIB" Web site, or the Collection "CD."

v READ/MVS requires service for APAR PQ75262, if you place Extended shelves
in a z/OS sequential dataset repository.

v Managing your own and other manufacturer's Books, PDFs, and other
publications
The Softcopy Librarian will let you track shelves, Books, PDFs, and other
publications that you create or that you might receive with products from
companies other that IBM.

Note: CD Collections of softcopy shelves and associated publications from
others - OEM (Original Equipment Manufacturers) - must be built using
the IBM BookManager shelf architecture (for shelves containing Books), or
the extended shelf architecture (for shelves containing PDFs) and
BookManager Build or builder application for the softcopy publication.
Use IBM BookManager Softcopy Reader to build Extended Shelves.
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v Available on all IBM Online Library CDs and from the IBM Web Site
The Softcopy Librarian is available, at no cost, on all IBM Online Library
collections and on other IBM product CDs.
The latest version of the Softcopy Librarian is also available and can be
downloaded by clicking the download link at the bottom of the "IBM Softcopy
Librarian" page at http://www.ibm.com/support/docview.wss?rs=4
&uid=swg27018846.

Some Terms You Should Know
Here are some Softcopy Librarian terms with which you should become familiar:

Source. Is the place from where you can obtain the shelves and associated publications that you want to place onto
your system. Sources can include:
v CD drive for CD collections from IBM or other manufacturers
v The Internet for connection to IBM's online library or other online libraries
v A local hard drive or server for the shelves and associated publications you can create

Repository. Is the place where your shelves, Books, PDFs, and associated publications are stored. Using Softcopy
Librarian, you specify where the repository is located and how to access it. You can define multiple repositories in
these locations:
v z/OS host sequential data sets - identified by a high-level qualifier
v z/OS Unix System Services hierarchical file system - identified by an HFS directory,
v A Unix-like server - identified by a Unix-like directory
v A hard drive on a local PC or LAN server - identified by a PC directory

Catalog. Is a Softcopy Librarian file that lists the softcopy items contained in a Softcopy Librarian repository. You
can create a catalog when you set up a new, empty repository. However, the catalog is automatically updated every
time you use the Softcopy Librarian to update your repository. The Softcopy Librarian builds a catalog by querying
the contents of the directory or the high-level qualifier (HLQ) specified during the setup of the repository and then
builds the catalog information.

Overview of Setting Up the Softcopy Librarian
In general, the steps that you must plan for are:

1. Determine whether your hosts and workstations meet the software and
hardware requirements for using the Softcopy Librarian.

2. Install the Softcopy Librarian on your workstation.

3. Set up one or more repositories using:
v z/OS repositories in sequential data sets.
v z/OS repositories in z/OS Unix System Services hierarchical files.
v Unix-like repositories.
v PC or LAN repositories.

4. Create a catalog for each repository.

5. Transfer shelves and associated publications to your repositories.

6. Maintain the repositories by identifying, replacing and/or deleting softcopy
items.

Overview of Using the Softcopy Librarian
After you have installed and set up the Softcopy Librarian, you can use it to help
you:

Chapter 6. Introducing the Softcopy Librarian 45

|
|
|
|

http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018846
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018846


v Compare the contents of any source (that is, a CD you received, the contents of
a supported Web site, or the hard drive of a server) with the catalog for any of
your repositories.
This comparison will show you which shelves, Books, PDFs, and associated
publications on that source are new, updated, installed, partial, or down level.

v Upload only new, updated, or partial shelves to your repository.
This saves you time and DASD space and still keeps your repository up to date.
The catalog is updated automatically whenever you upload to the repository.

v Maintain your host repository.
The Softcopy Librarian shows you which shelves in your repository can be
replaced by the new and updated ones that you just transferred.
You can:
– List the Books, PDFs or other publications in a shelf
– See which Books, PDFs or other publications if any, are missing from any of

the shelves
– See which Books, PDFs, and other publications are “orphaned”, that is not in

any shelf.
All this makes it easy for you to delete the shelves and Books, PDFs or other
publications that have been replaced or are no longer needed.

Software and Hardware Requirements
This section describes the software and hardware required to install and use the
Softcopy Librarian on your hosts and workstations.

Software and Hardware Requirements for Your Workstation
This section describes the software and hardware requirements for the workstation
on which you will do the following:
v Install the Softcopy Librarian
v Create a catalog of softcopy that resides in your repositories
v Transfer softcopy shelves, BOOKs, PDFs, and other publications to your

repository.

It must have the following software and hardware:

A workstation that consists of:
v A minimum 1GHz processor with 1GB RAM is recommended.
v One of the following operating systems:

– Microsoft Windows XP, Windows Vista (with a minimum of Service Pack 1
installed) or Windows 7 (32 or 64-bit)

v To use z/OS repositories, a TCP/IP link that supports FTP communications with
your host
– Current support is for IBM TCP/IP FTP only.

v To use LAN server repositories, a network connection which allows you to
access the LAN server as a drive letter

v To use local PC repositories, no additional requirements
v To use CD-ROM collections as a source, a CD-ROM drive
v To use the Internet as a source or to check for updates to the Softcopy Librarian,

an Internet connection
v A minimum of 100MB of space on your hard drive
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Software and Hardware Requirements for Your z/OS Host
Repository

This section describes the software and hardware requirements for an z/OS host
on which you will maintain one or more softcopy repositories.

Your host must have the following software and hardware:
v A z/OS Host system
v A TCP/IP link that supports FTP communications from your workstation

Current support is for IBM TCP/IP FTP only.
Your destination host must be inside your firewall, the Softcopy Librarian does
not provide proxy support for this transfer.

v Sufficient DASD space for the shelves, BOOKs, PDFs, and other publications that
will reside in your repositories.

v If you plan to:
– Use sequential dataset repositories, and
– store Extended Shelves in them, and
– allow your users to use READ/MVS
Then you must install service for READ/MVS APAR PQ75262, to prevent
READ/MVS from listing Extended Shelves in its List of Shelves (READ/MVS
does not currently support Extended Shelves).

Software and Hardware Requirements for a Unix-like
Repository

This section describes the software and hardware requirements for a Unix-like
server on which you will maintain one or more softcopy repositories.

Your server must have the following software and hardware:
v One of the following operating systems:

– AIX
– Linux
– Any other Unix type operating system

v A TCP/IP link that supports FTP communications from your workstation
Current support is for IBM TCP/IP FTP only.
Your destination server must be inside your firewall, the Softcopy Librarian does
not provide proxy support for this transfer.

v Sufficient DASD space for the shelves, BOOKs, PDFs, and other publications that
will reside in your repositories.

Software and Hardware Requirements for Your PC or LAN
Repository

This section describes the software and hardware requirements for a PC or LAN
on which you will keep your softcopy repositories.
v You must be able to access the repository's directory as either a drive letter or

via a network name, such as \\server1\softcopy.
v Sufficient DASD space for the shelves, BOOKs, PDFs, and other publications that

will reside in your repositories.

If you meet the requirements for installing and using the Softcopy Librarian, when
you are ready, you can continue with the information in “Planning for Your
Repositories” on page 48 to help plan your repositories.
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Planning for Your Repositories
This section discusses what you will need to know and some of the decisions that
you must make in preparation for setting up your own repositories of shelves,
Books, PDFs, and other publications.

Note: In addition to, or instead of, setting up your own repositories, you can
access the IBM Online Library on the Internet at this URL:
http://www.ibm.com/shop/publications/order

You need only a browser to access the entire z/OS, z/VM, VM, and z/VSE
libraries.

What Does the Softcopy Librarian Manage?
The Softcopy Librarian actively manages the following types of files:
v BookManager

– Books (BOOK or .BOO files)
– Shelves (BKSHELF or .BKS files)
– Extended Shelves (XKSHELF or .XKS files)
– Shelf indexes (BKINDEX or .BKI files)

v IBM supplied PDF documents (PDF or .PDF files)

Active management involves not just transferring files to your repositories, it also
includes:
v Maintaining a catalog of the contents for each of your repositories
v Comparing what is currently in your repositories with new sources of shelves,

Books, PDFs, and associated publications.
v Providing you with the comparative status of the items in the source in relation

to the contents of your current repositories.
v Updating the catalogs whenever you transfer new shelves, Books, PDFs, and

other publications to your repositories
v Identifying items in your repositories that can be removed because there are

newer versions of these items also in your repositories.

How Many Repositories Might I Need?
The simplest arrangement is one repository that anyone can access. You must
define at least one repository for the Softcopy Librarian to function.

You might need more than one repository depending upon several factors, which
can include:
v All your users do not have access to the same host or server
v Even if they are on the same host they may not have access to the same LPAR
v You have a large number of Books, PDFs and other publications that are easier

to manage in unique sets, for example, IBM and non-IBM.
v If you are migrating from one version or release of a system to another, you

might want to keep the Books, PDFs and other publications in separate
repositories to make it easier to delete the older set.

v If you are running a test release of your system along with your production
release, you might want to keep the two separate from each other.
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Where Can I Locate My Repositories?
You can set up one or more host repositories of softcopy shelves, Books, PDFs, and
other publications in any of the following places:
v On z/OS hosts:

– In sequential data sets
– In the hierarchical files (HFS) of Unix System Services

v On Linux, AIX or other Unix-like servers
v On LAN servers
v On local workstations

What Information Must I Gather before I Can Define a
Repository

You must provide the following information when you define your repository:
v The arrangement of your repositories.

– How many you plan to have
– What they will contain
– Where they will be located

v For all repositories: A name for each new repository.

Note: This name can be anything you want. It is the name that the Softcopy
Librarian uses on your workstation to identify your repositories.

v For host and Unix-like repositories only: The name or IP address and the user
ID and password you use to access your host or server.

v For all repositories: High level qualifiers or directories, which will contain these
files:
– Book (.BOOK or .BOO)
– Index (BKINDEX or .BKI)
– PDF (.PDF)
– Shelves (.BKSHELF or .BKS)
– Extended Shelves (.XKSHELF or .XKS)

Note: High Level Qualifiers and directories can be used for all file types.

Note: For host repositories in sequential data sets only: Your shelves, Books,
PDFs, and other publications do not require unique HLQs. For
example, if your BookManager code is installed under IBMBK, then the
shelves, Books, PDFs, and other publications could be installed under
IBMBK.SOFTCOPY.

v For host repositories in sequential data sets only

– A high-level qualifier for the Softcopy Librarian's shelf list.
– The type of DASD device you are using
– The block size for that DASD device (provided)
– The volume in which the data sets will reside
– For SMS users only: The applicable data, management, and storage classes

that you are using
v For host, Unix-type, and LAN server repositories only Any FTP commands

required by your location to transfer the shelves and associated publications
from the workstation to your host or server.
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Installing the Softcopy Librarian
This section describes:
v Where you can find the Softcopy Librarian installation package
v How to determine which version is available for download
v How to determine whether an updated version is available
v How to install the Softcopy Librarian on Windows XP, Windows Vista (with a

minimum of Service Pack 1 installed) and Windows 7 (32 or 64-bit)
workstations.

Softcopy Tools Installation Program
This section assumes that you are not using the softcopy tools installation
program to install IBM Softcopy Librarian. For information about using the
softcopy tools installation program, see Chapter 4, “Program for Installing
Softcopy Tools,” on page 19.

Locating the Softcopy Librarian Package
The install package is located on the CD-ROM containing tools, which is part of
the IBM Online Library collections. The package is also located on the DVD, which
is part of the IBM Online Library DVD collections. The package, in a file named
EBRSCLWJ.EXE, is in the SCL directory.
\SCL\EBRSCLWJ.EXE

The latest version of the Windows install package is also available by clicking the
download link at the bottom of the “IBM Softcopy Librarian” page at
http://www.ibm.com/support/docview.wss?rs=4&uid=swg27018846.

The filename of the Softcopy Librarian install package is EBRSCLWJ.EXE.

Determining If a Later Version Is Available for Download
From time-to-time, an updated version of the Softcopy Librarian is made available
for download from the PUBLIB Web site. If you are using a Windows workstation,
you can check automatically or manually if a later version than the one you
currently have installed on your workstation is available. You might want to do
either of these checks occasionally.

Checking for a Later Version Automatically
To check automatically, do the following:

1. On the Softcopy Librarian's menu bar, select Help.

2. In the Help pull-down menu, select Check for Updates (automatic).

When selected, the Check for Updates (automatic) choice causes the Softcopy
Librarian, at Startup, to compare the version that you have installed with the
version that is currently available at the Softcopy Librarian Web site.

3. If there is a later version available at the Web site, you will be asked if you
want to download it. If you do, click OK.
If you choose to download it, you will also be asked if you want to install it.

4. If you want to install the new version, click OK.

If you choose to install it, follow the instructions in “Installing the Softcopy
Librarian on a Windows Workstation” on page 51.
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Note: If, because of your firewall, the Softcopy Librarian cannot perform the
automatic check, you can use the manual check described below.

Checking for a Later Version Manually
To check manually, do the following:

1. Locate the Check for Updates (manual) choice. Do one of the following:

v From the Windows Start Menu:

a. Go the Start menu.
b. Select Programs.
c. From the Programs menu, select IBM Softcopy Librarian V4.
d. From the Service menu, select Check for Updates (manual).

v From the Softcopy Librarian Help Menu:

a. On the Softcopy Librarian's menu bar, select Help.
b. In the Help pull-down menu, select Check for Updates (manual).

The Check for Updates (manual) choice, presents you with an HTML page
containing a link to the Softcopy Librarian's Readme file.

2. Click on the link to the Readme file and look at the version listed.

The first line of the Readme contains the version number.

3. Compare the version listed in the Readme with the version that you have
installed.
The Readme also explains how to determine which version you have installed.

4. If there is a later version available on the Web site, you can download the
Windows version of the Softcopy Librarian install package.

Installing the Softcopy Librarian on a Windows Workstation
Only Softcopy Librarian V4.3, and greater, is supported on Windows Vista.

Only Softcopy Librarian V4.4, and greater is supported on Windows 7.

Note: Prior to Softcopy Librarian V4.6, for certain installations of Windows Vista
or Windows 7 it may be necessary to create a secondary Windows
administrator userid under which to install and run Softcopy Librarian.
Specifically, this is required if the primary administrator id being used does
not have its own entry in the c:\users\ directory tree.

To install the Softcopy Librarian on a Windows workstation, do the following:

1. Locate the install package EBRSCLWJ.EXE and invoke it from Windows
Explorer, the Start->Run prompt, or a command prompt.
The InstallShield Wizard window appears. When the Softcopy Librarian
code is unpacked, the Choose Destination Location window appears in the
IBM Softcopy Librarian Setup screen.

2. In the Choose Destination Location window, you can accept the default
destination C:\Program Files\IBM\IBM Softcopy Librarian V4 or choose
another. When you are ready, press the Next> button.
The Start Copying Files window appears to confirm your choices.

3. In the Start Copying Files window, press the Next> button.

Chapter 6. Introducing the Softcopy Librarian 51



A progress indicator shows the Softcopy Librarian files being installed. When
the installation is complete, the Installation Wizard Complete window
appears.

4. In the Installation Wizard Complete window, press the Finish button.

After you have installed the Softcopy Librarian code, you are ready to start the
Softcopy Librarian and prepare your host or server for setting up a repository.
Refer to the Softcopy Librarian User's Guide on this collection.

Starting the Softcopy Librarian from a Windows Workstation
To start the Softcopy Librarian, do the following:
1. Double click the Softcopy Librarian icon on the Windows desktop.

or
Go to the Start menu.

2. In the Start menu, select the Programs choice.
3. In the Programs menu, select the IBM Softcopy Librarian V4 choice.
4. In the IBM Softcopy Librarian, select the Softcopy Librarian choice.

The Softcopy Librarian window appears.
If you are starting the Softcopy Librarian for the first time: The SCL - First Time
Usage window will also open.

5. Setup a default source for your CD-ROM drive: type the drive letter for your
CD-ROM drive in the CD-ROM Drive field.
The Softcopy Librarian will create a default source using your CD-ROM drive.

6. Click on the Define CD Source button. The default source will be renamed
CD-ROM - x\ drive.

Note: The Softcopy Librarian program may be run from the command line
interface, however when doing so on a Windows 7 64-bit system, it is
important to note that only 32-bit Java is supported. It is the responsibility
of the user to ensure that 64-bit Java is not launched. If 64-bit Java is
inadvertently launched (usually the result of the PATH environment variable
setting) certain dll compatibility errors will prevent the program from
running.
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Part 4. Using BookManager and PDF Softcopy Files
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Chapter 7. Setting Autorun Preferences for Collection Discs

Starting in March 2002, many IBM softcopy collections include a Windows-based
program to set autorun preferences for the programs to run when a collection disc
is inserted. For example, you can choose to automatically start Softcopy Reader, the
softcopy index to the entire collection, or the softcopy index for a single disc when
you insert a disc containing softcopy files. Or, you can choose not to have anything
start automatically.

The program (AUTORUN.EXE) runs automatically the first time you insert a disc
that contains it. A window opens where you can select the autorun preferences for
each type of collection disc. These are the preferences you can set.

Note: Extended shelf files can be opened only by Softcopy Reader 3.0 (or later).
v For discs containing only BookManager files:

– Open the IBM Softcopy Reader.
– Open the disc index.
– Open the collection index.
– Show the autorun preferences window.
– Do not start any programs.

v For discs containing BookManager and PDF files:
– Open the IBM Softcopy Reader.
– Open the disc index.
– Open the collection index.
– Show the autorun preferences window.
– Do not start any programs.

v For discs containing only PDF files:
– Open the disc index.
– Open the collection index.
– Show the autorun preferences window.
– Do not start any programs.

v For discs containing PDF and extended shelf files:
– Open the IBM Softcopy Reader. (This option is available only if Softcopy

Reader 3.0 or later is installed.)
– Open the disc index.
– Open the collection index.
– Show the autorun preferences window.
– Do not start any programs.

v For discs containing BookManager, extended shelf, and PDF files:
– Open the IBM Softcopy Reader.
– Open the disc index.
– Open the collection index.
– Show the autorun preferences window.
– Do not start any programs.

To set your autorun preferences:
1. For each type of collection disc, select an autorun preference from the selection

list.
2. To preview a preference before setting it, select a tool to use now for the

current disc.
3. When you are done, click the OK button.
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After you save these preferences, the program does not run again unless you have
set a preference to run it every time a disc containing the program is inserted.

To change your preferences after initially setting them, do one of the following:
v If you are already viewing the collection index (on a disc other than the tools

disc), click on the link to AUTORUN.EXE in the tips section.
v Otherwise, go to the root directory of a collection disc (other than the tools disc)

and run AUTORUN.EXE.
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Chapter 8. Using the Softcopy Collection Index with a
Softcopy Repository (Windows Users Only)

After transferring online books from a softcopy collection to your own repository,
you might want to provide the same access to these files as you have when the
softcopy collection index (SCINDEX.HTM) is loaded within the SCFRAME.HTM
frameset on a collection disc. The files can be:
v On your desktop
v On a local network (such as a network drive or a LAN server)
v Served by an HTTP server

Here are some tips for using the softcopy collection index with a softcopy
repository.
v Recommended browser: To make full use of the support provided in

SCFRAME.HTM, use Internet Explorer 5.0 or later.
v For viewing BookManager files: Install IBM Softcopy Reader 2.3.8 or later. This

level of the product provides MIME-type information to simplify access to
BookManager files through a browser interface.

v For viewing PDF files: Install Adobe Reader. To access groups of PDF files from
extended shelves, install IBM Softcopy Reader 3.0 (or later).

v For files on a network drive: Map the network drive to a local drive letter. This
ensures that the browser has access to the files.
To provide access to the BookManager files on that drive, open Shelf Organizer
and add the local drive letter and path to the list of user-defined directories.

v For files served by an HTTP server (Netscape users only): To launch
BookManager books and shelves with Softcopy Reader from the Netscape
browser, the HTTP server administrator must modify the HTTP server
configuration.
These are the specific MIME content type/subtype assignments needed for the
filetype extensions supported by Softcopy Reader.

Extension MIME content type/subtype
(Softcopy Reader 3.0 or later)

MIME content type/subtype
(earlier levels of Softcopy Reader)

.boo application/x-boo application/boo

.bks application/x-bks application/boo

.xks application/x-xks not supported

These assignments correspond to the content type values specified by the
Softcopy Reader installation program in the .boo, .bks, and .xks helper
application information at the client.
The method to make these assignments depends on the HTTP server. Here are
some examples:
– For the Apache HTTP server, create AddType directives in the httpd.conf file.
– For the Microsoft IIS HTTP server, create MimeMap registry key entries.
– For the Lotus® Go HTTP server, use the Configuration and Administration

function to add new entries to the Mime Types form.
v Copy the contents of the root directory and \AUTOHTML directory from a

numbered disc in the desired collection, using the same directory structure as on
the collection.
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For example, you could create a directory called \IBMBOOKS and nest the copied
directories under it. Copy the files from the root directory of the collection into
this top-level directory, and copy the contents of the \AUTOHTML directory of the
collection disc into the \AUTOHTML directory under your top-level directory.
You should end up with a directory structure similar to this:
IBMBOOKS

|
-- > BOOKS
|
-- > SHELVES
|
-- > PDF
|
-- > AUTOHTML

v For files not served by an HTTP server: Delete the DISC.JS and CHKDISC.JS
files from the \AUTOHTML directory on your system, and delete DISC.HTM from
the top-level directory (such as IBMBOOKS). Deleting these files enables the
SCINDEX.HTM file to work as if the softcopy files it links to are all on one disc.

v The links in SCINDEX.HTM assume that the book and shelf files are in the
\BOOKS and \SHELVES directories, and the PDF files are in the \PDF directory. If
you moved the files into other directories, you must edit the links in
SCINDEX.HTM to point to those directories.

v The links assume that you are using SCINDEX.HTM and the files it links to
(books, shelves, PDFs) from the same drive. There might be situations when you
cannot do this. For instance, if you are linking to books that are accessible on a
network server, you must change the links to match the drive letter on which
the linked-to files are mounted.

v To create a desktop shortcut for launching SCFRAME.HTM from within your
top-level directory (such as \IBMBOOKS):
1. Right-click SCFRAME.HTM.
2. Drag it to your desktop.
3. Select the option to Create Shortcut Here.

v Each time the collection is updated, refresh your repository from the contents of
the root directory and \AUTOHTML directory of the collection discs. The interface is
constantly being improved, and this is the only way to be assured of getting the
latest code.
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Chapter 9. Learning to Use IBM Softcopy Reader and Other
IBM Readers

After you insert a disc for an IBM softcopy collection, you can use the Shelf
Organizer of the IBM Softcopy Reader to see a list of the shelves you have
available.
v From a bookshelf, you can access, read, and search BookManager BOOK files.
v With Softcopy Reader 3.0 (or later), the Shelf Organizer supports extended

shelves (XKS files). From an extended shelf, you can access PDF files. However,
reading the PDF files still requires a separate program, such as Adobe Reader or
Adobe Acrobat. You can also use Softcopy Reader V3.6 (or later) to search
indexed extended shelves of PDFs, and the IBM Advanced Linguistic Search
Plug-in (ALSPI) for Adobe V1.3 (or later) to search individual PDFs that have
been enabled with the Advanced Linguistic Search Index. The version of IBM
ALSPI to use depends on the installed version of Adobe Reader (or Acrobat):
– Version 1.5 and 1.5.1 of IBM ALSPI run on a Windows client having Adobe

Reader (or Adobe Acrobat) 10 or 11
– Version 1.4.1 of IBM ALSPI runs on a Windows client having Adobe Reader

(or Adobe Acrobat) 9
– Version 1.4 of IBM ALSPI runs on a Windows client having Adobe Reader (or

Adobe Acrobat) 8
– Version 1.3 of IBM ALSPI runs on a Windows client having Adobe Reader (or

Adobe Acrobat ) 7

For detailed instructions on using Softcopy Reader, the BookManager READ/VM
licensed program, or the IBM BookManager READ component of z/OS, you can
refer to one of the following:
v The README and BOO files in the directory where the Softcopy Reader was

installed, or IBM Softcopy Reader User's Guide, SC34-3164 (in the IBM Online
Library Reference Bookshelf on most softcopy collections)

v IBM BookManager READ/VM: Displaying Online Books, SC23-0449 (in the IBM
Online Library Omnibus Edition: VM Collection, SK2T-2067)

v IBM BookManager READ/MVS: Displaying Online Books, SC38-2034 (in the z/OS
Collection, SK3T-4269)
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Chapter 10. Printing Hardcopy from Softcopy Files

You can print your own hardcopy when you need it from the softcopy files
provided on IBM softcopy collections, on a library on the Internet, or on a local
repository or Web site.
v If you are viewing a softcopy file and you want hardcopy of a topic or two, you

can print from the BOOK or PDF file you are viewing.
v For a complete hardcopy book that looks like a traditional manual you would

order from IBM, print the PDF file for the book.

Printing from a BOOK File
How to print topics from a BookManager BOOK file depends on how you are
viewing that file:
v From your workstation, with IBM Softcopy Reader (for example, to read a

BookManager BOOK file from a CD-ROM)
v From a library on the Internet (such as the z/OS Internet library) that uses

Library Server or BookManager BookServer to display BookManager BOOK files
v From a host, with BookManager READ

Because the printout is from the BookManager BOOK file itself, the output looks
like the BookManager BOOK file, with numbered sections and subsections instead
of page numbers. But remember—you should only use the BookManager BOOK
file to print a topic or two, and not the whole book.

With Library Server or BookManager BookServer, if a PDF file is present for the
document, Adobe® Reader™ can be launched to print the desired pages in the PDF.

Using IBM Softcopy Reader
To print the topic you are currently viewing:
1. Click on the Print icon or go to File → Print. This opens a Print window.
2. Click on the Current button. This opens your workstation Print window.
3. Complete the print options in your workstation Print window, then click OK to

print the current topic.

To print selected topics:
1. Select the desired topics in the “table of contents” frame. Hold down the Shift

key to select a list of topics, or hold down the Ctrl key to select specific topics.
To print all the topics in a chapter, expand the chapter by clicking the + sign
next to the chapter heading in the table of contents. Then highlight all the
topics in the chapter that you want to print. If you highlight only the main
chapter topic without expanding it, you will print only the page that displays
for the main chapter topic, including a list of subtopics for the chapter.

2. Click on the Print icon or go to File → Print. This opens a Print window.
3. Click on the Selected button. This opens your workstation Print window.
4. Complete the print options in your workstation Print window, then click OK to

print the selected topics.
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Using the z/OS Internet Library
Printing from the z/OS Internet library gives you a very high-quality output. To
use the z/OS Internet library, go to http://www.ibm.com/zseries/zos/bkserv/.

To print the topic you are currently viewing:
1. Click your browser Print icon.
2. Follow the usual steps for printing from your browser.

To print selected topics:
1. Click the LibraryServer Print icon (not your browser Print icon). This opens a

Print Preview window.
2. Highlight the desired topics from the selection box. Hold down the Shift key to

select a list of topics or hold down the Ctrl key to select specific topics.
3. Click the Selected topics button. You then see a formatted preview of the

topics.
4. Use your browser's print facility to produce a hardcopy document of the

information shown.

To print pages from a BookManager BOOK file you are currently viewing:
1. Click the LibraryServer Download PDF icon, if selectable.
2. When presented with the File Download dialog, select “Open this file from its

current location” and then click “OK”, which will launch the Adobe Reader for
the PDF.

3. From within the Adobe Reader, the desired pages in the PDF document may be
printed via the Adobe Reader print function.

To print pages from a PDF document you select from a bookshelf, search results
list, or a catalog list:
1. Click the PDF icon, if present.
2. When presented with the File Download dialog, select “Open this file from its

current location” and then click “OK”, which will launch the Adobe Reader for
the PDF.

3. From within the Adobe Reader, the desired pages in the PDF document may be
printed via the Adobe Reader print function.

Using BookManager READ
If your company has established a softcopy repository on the host (z/OS, z/VM,
or VM), you can use the Print option of BookManager READ to get hardcopy of a
topic or two. However, BookManager READ by itself (without other programs
such as DCF and BookMaster®, which are separate programs) provides a lower
quality print than printing from Library Server (or BookManager BookServer)—it is
essentially a screen print. Sometimes, though, BookManager READ may be the
only available option. In that case, here's how to proceed.
1. Open the book you are interested in.
2. To set your print options, select the Options pull-down menu, then select the

print option and specify the desired values.
3. Use the PRINT command to print one or more topics in the book.

(BookManager READ/MVS invokes the ISPF panels you normally use to print
at your site. BookManager READ/VM invokes the program specified in the
print options.)

Enter the command in one of the following ways:
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PRINT
PRINT topic1
PRINT topic1 TO topic2
PRINT topic1 FOR number-of-topics
v To print the current topic, enter the PRINT command without operands.
v To print all of a topic (such as 1.0), including its subtopics, enter the next topic

number (such as 2.0), then prev. Make note of the last topic number (for
example, 1.6.4), then enter the PRINT command with the complete range
(PRINT 1.0 TO 1.6.4).

Printing a PDF File
In the Windows workstation environment, you can use Adobe Reader or Adobe
Acrobat to view and print PDF files. But sometimes you need alternatives. For
large or graphically complex books that need to be printed on AFP™ printer, you
might want to have the host handle the transforms, instead doing it on the
workstation before sending the file. Also, you may want to be able to print PDFs
stored in a host repository. z/OS or OS/390 and the optional Infoprint Server
feature support these additional options for printing PDF files.

Using Adobe Reader
1. Install Adobe Reader on your computer. Starting in September 2000, many IBM

softcopy collections contain a recent level of an Adobe Reader (at no extra
charge). You can also go to the Adobe Web site at http://www.adobe.com for
more recent readers or more information.

2. Open the PDF you want to print. The PDF can be on a CD-ROM, on the z/OS
Internet library—anywhere you can view it with an Adobe Reader.

3. Select Adobe Reader's Print option.
4. Select the desired printer and specify other print options as appropriate.
5. Click OK to print the file.

Reminder: Be aware that if you decide to print a subset of a book from a PDF file,
the “pages” (as understood by Adobe Reader) are totally sequential.
Adobe Reader considers the front cover to be page 1 and proceeds
from there—no Roman numeral page numbers for the front matter, no
section numbering. So, when you specify the pages to print, be sure to
enter the page numbers from Adobe Reader's point of view (check the
page box at the bottom of the screen) and not as they appear on the
individual pages of the book.

Using a LAN- or Host-attached AFP Printer
Some PDF files are too large or graphically complex to print on the typical desktop
or LAN-attached printer. z/OS and OS/390 provide a solution. Infoprint Server (an
optional, priced feature of z/OS and OS/390), with the Infoprint Server Transforms
(free to Infoprint Server customers), lets you print high-quality hardcopy of PDF
files on high-speed LAN-attached or host-attached AFP printers managed by PSF
for OS/390.
v Workstation users on a LAN connected to z/OS or OS/390 can print PDFs from

a CD-ROM, the Web, or the LAN.
v Host users can print PDFs from an MVS or HFS data set, such as a host

repository of softcopy files, or PDFs uploaded from a CD-ROM.

At a high-level, these are the requirements:
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v InfoPrint Server and the InfoPrint Server Transforms must be installed on z/OS
or OS/390.

v The system administrator must define one or more AFP printers to Infoprint
Server and configure the printer definitions to use the PDF to AFP transform.
(PostScript to AFP and PCL to AFP transforms are also available at no extra
cost.)

v For host users, the system administrator can customize the AOPPRINT JCL
procedure to create a job for printing PDF documents on AFP printers. Host
users can also use the OS/390 UNIX lp command to print PDF documents on
AFP printers, and the OS/390 UNIX pdf2afp command to create AFP
documents.

v Workstation users can download an Infoprint Server Windows client to route
workstation print requests to Infoprint Server on z/OS and to AFP printers.
Workstation users can also submit print requests using the SMB protocol
available on all Windows systems, and the TCP/IP LPR command available on
most workstation platforms.

For an overview of this support, visit http://www.ibm.com/printers. For details on
this support, see the z/OS Infoprint Server documentation in any of these
locations:
v z/OS Collection, SK3T-4269
v z/OS Internet library, at http://www.ibm.com/zseries/zos/bkserv/
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Chapter 11. Using IBM Softcopy Collections on Your z/OS,
z/VM, or VM Host

After transferring bookshelves, indexes, and books to your z/OS, z/VM, or VM
host, you need to make the bookshelves available and usable on your host system.
This chapter explains how to do this.

Making Bookshelves Available on z/OS
1. Start the z/OS BookManager Reader and go to the list of bookshelves.

2. Do not select any bookshelves. Select Books choice on the action bar and
press Enter.

3. In the window that appears, select 6. Perform file functions.

4. In the window that appears, select 5. Add.

5. Type, between single quotation marks, the name of the first bookshelf you
uploaded and press Enter.
’ibmbk.ez2shelf-name.bkshelf’

You may want to add to the master list, which is defined by the QLSHELF
parameter in the EOXVOPTS REXX EXEC. For example, if you look at the
EOXVOPTS member, you see a statement like this:
QLSHELF = "’EOY.BKLSHELF’"

The name of the master list here is:
’EOY.BKLSHELF’ The bookshelf is now added.

6. Repeat steps 4, 5, and 6 for each bookshelf in BKSHELF.LST. When you have
finished, press F12 to return to the list of bookshelves.

7. Type a slash (/) next to each bookshelf you just added.

8. Select the Books choice on the action bar and press Enter.

9. In the window that appears, select 6. Perform file functions.

10. In the window that appears, select 4. Edit.

11. In the window that appears, select 4. Add data set names.

12. In the window that appears, type the high-level qualifier that you added to
each file name, and press Enter. For example, ibmbk

13. Press F12 to return to the previous window.

14. Press F6 to skip the bookshelf you just added. The next bookshelf you
selected appears.

15. Repeat steps 10, 11, 12, and 13 for each bookshelf you selected.

16. When you have finished with all the bookshelves, a window with the list of
bookshelves reappears.

17. Press F5 to refresh the list and see the newly added bookshelves.

You are now ready to use the new bookshelves. You can use the BOOKMGR
command in your host session to view the bookshelves and books in a collection

© Copyright IBM Corp. 1996, 2013 65



of IBM books. Refer to the BookManager READ/MVS books for more information
about using BookManager READ on your host.

Note: To conserve space on your host DASD, you can release any unused space
you allocated when you uploaded the books and bookshelf search indexes.
You can use DFHSM to migrate the data set.

Making Bookshelves Available on z/VM or VM
Although it is not required, you should add the bookshelf files to the
BookManager public library. Otherwise, you can access them directly if the
minidisk containing the files is currently accessible.

When you are finished transferring files to your z/VM or VM host, you can use
the BOOKMGR command in your host session to view the bookshelves and
books.
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Chapter 12. Sharing IBM Softcopy Collections with Your z/VSE
Host

You can share IBM softcopy collections with the users of your z/VSE host in two
ways:
v For z/VSE running under VM: You can install the BookManager READ/VM

licensed program on your VM host and upload the files you want to use.
v For stand-alone z/VSE: You can install IBM Softcopy Reader on your

workstations and use the collections at these workstations.

Distributing IBM Softcopy Collections to z/VSE Workstations
You can distribute IBM softcopy collections to z/VSE workstations that do not
have CD-ROM or DVD readers by using diskettes and using the PUN Queue.

Distributing IBM Softcopy Collections Using Diskettes
You can copy the IBM Softcopy Reader and softcopy files to diskettes on one
workstation and copy them to the hard disk on another workstation.

Uploading Books, Bookshelves, and Indexes to the PUN
Queue

You can transfer files to the VSE/POWER PUN queue from one workstation and
then retrieve them from the queue at another workstation.

1. At your z/VSE host, make sure the VSE/POWER data file has enough free
space. Enter the command D Q at the system console.
The system displays the percentage of space already used in the data queue.
To determine how much free space is available in the data file, multiply the
displayed values for free DBLK groups, DBLK group size, and DBLK size (free
DBLK groups × DBLK group size × DBLK size).
To send files, set up the z/VSE host for normal file transfer to or from a
workstation (see VSE/ESA Programming and Workstation Guide).

2. At the workstation OS/2 or DOS command prompt, switch to the drive with
the directory containing the files you want to transfer. If the books are on your
F drive, type: f:

3. Change to the directory on that drive containing the files. If the books are on
the \BOOKS directory, type: cd \books

4. Do one of the following to transfer files to the PUN queue:

v Use individual DOS or OS/2 SEND commands to transfer files to the PUN
queue. For example:
send dto32e00.boo dto32e00 (file=pun binary class=v dest=any
lrecl=4000

v Create an OS/2 command like the following to transfer three books to the
PUN queue at the same time:
SEND GETBOOK.CMD GETBOOK (FILE=PUN BINARY CLASS=V DEST=ANY LRECL=4000

SEND DTO32E00.BOO DTO32E00 (FILE=PUN BINARY CLASS=V DEST=ANY
LRECL=4000

© Copyright IBM Corp. 1996, 2013 67



SEND DTOU2000.BOO DTOU2000 (FILE=PUN BINARY CLASS=V DEST=ANY
LRECL=4000

SEND DTOR2000.BOO DTOR2000 (FILE=PUN BINARY CLASS=V DEST=ANY
LRECL=4000

Explanation:
– The command file sends three books to PUN.
– For DOS, this file would be named GETBOOK.BAT instead of

GETBOOK.CMD.
– CLASS=V designates the files belong to this specific queue class. You

should make sure PUN is not started for the class you select.
– DEST=ANY so any user can retrieve the books from the queue.
– GETBOOK.CMD is a file for retrieving the books.

Receiving Books, Bookshelves, and Indexes from the PUN
Queue

After you have transferred files to the VSE/POWER PUN queue from a
workstation, you can retrieve them from the queue at another workstation.

Before receiving any files, you should decide into which directory or partition on
the receiving workstation you want to put them. The following example assumes
you want to put the books into the \BOOKS directory on your C hard disk. After you
decide where you want to put the books, make sure the destination you chose is in
the PATH statement on the workstation.

1. Set up the z/VSE host for normal file transfer to a workstation.

2. At the workstation receiving the files from the PUN queue, use individual
DOS or OS/2 RECEIVE commands to transfer files from PUN.
If you sent a command file like the one described below to the PUN queue,
you can receive it, and use it to receive the other files. For example, to receive
the GETBOOK file from PUN queue:
For OS/2: receive d:\books\getbook.cmd getbook (file=pun binary class=v

For DOS: receive d:\books\getbook.bat getbook (file=pun binary class=v

After you have retrieved the command file, use it to retrieve one or more
queue entries from PUN. For example, if the GETBOOK file contains RECEIVE
commands for three books, entering getbook receives the following files:
RECEIVE D:\BOOKS\DTO32E00.BOO DTO32E00 (FILE=PUN BINARY CLASS=V

RECEIVE D:\BOOKS\DTOU2000.BOO DTOU2000 (FILE=PUN BINARY CLASS=V

RECEIVE D:\BOOKS\DTOOR000.BOO DTOOR000 (FILE=PUN BINARY CLASS=V

The queue entries remain in PUN until you use PDELETE to delete them.
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Chapter 13. Using IBM Softcopy Collections on an AS/400
System

You can share IBM softcopy collections on your AS/400 System using InfoSeeker
on the AS/400 System to read books or using IBM Softcopy Reader on an
AS/400-attached workstation.

AS/400 InfoSeeker became part of the Operating System/400® in Version 3 Release
1. It is a version of the BookManager® Library Reader specially designed for use on
the AS/400 System. With InfoSeeker, you can view online books from any
workstation, including non-programmable workstations.

The PC-based Softcopy Reader provides features not available with InfoSeeker,
such as allowing you to:
v Display the pictures in the books
v Add margin notes to the books
v Print topics with better quality
v Print pictures

On AS/400 Advanced Series systems using PowerPC®® technology and OS/400
Version 3 Release 6, you can install online books on the system by using the
AS/400 CD-ROM drive. See “Installing Books on OS/400 Version 3 Release 6 or
Later” on page 71 for the procedure to do this.

On Version 3 Release 1 systems, you can transfer online books from your CD-ROM
to an AS/400 directory. You must do this if you want to view the books using
InfoSeeker from a non-programmable workstation attached to an AS/400 System.

You can also use IBM softcopy collections from a CD-ROM or DVD drive on a
workstation.

Notes:

1. OS/400 support of InfoSeeker exists through, but not beyond, Version 4 Release
3 of the base operating system.

2. Softcopy information for AS/400 systems is now provided through Information
Center CD-ROMs (such as AS/400 Information Center CD-ROM (V4), SK3T-2027)
instead of through softcopy collections.

Installing and Using InfoSeeker on Your AS/400 System
For information on setting up an IBM softcopy collection and using InfoSeeker, see:
v AS/400 InfoSeeker: Getting Started, SC41-3001 (V3R2)
v AS/400 InfoSeeker: Use, SC41-3002 (V3R2)

Once the books are installed, you start InfoSeeker by entering
strinfskr

on the AS/400 command line.
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Using Directories on the AS/400 System to Share Softcopy Collections
Client Access for OS/400 allows you to share the IBM books and bookshelves
among several users who have programmable workstations. Each workstation can
have the IBM Softcopy Reader installed or you can install the IBM Softcopy Reader
in a shared AS/400 directory.

For more information on setting up and using these directories, see AS/400 Client
Access for Windows 95/NT Setup, SC41-3512.

Using the SCRT to Install Books to an AS/400 System Directory
You can use the Softcopy Receiver Tool (SCRT) to transfer IBM softcopy collections
from a CD-ROM or DVD on your personal computer to a directory on an AS/400
System.

Final Shipment of SCRT in September 2001
The Softcopy Receiver Tool is no longer supported as of September 2001.

The SCRT is being shipped for the last time on the September and October
2001 softcopy collections. You should start using IBM Softcopy Librarian
instead.

Starting in December 2001, softcopy collections will not will not include the
SCRT. Instead, only the IBM Softcopy Librarian will be included.

Note the following considerations for AS/400 when running SCRT V1.3:
v The SCRT cannot install to a root drive on an AS/400 System.
v A drive must be assigned to the AS/400 System directory.

When using Client Access for AS/400, PC drive letters can be assigned to AS/400
directories (or folders). Normally, libraries on IBM softcopy collections are installed
to the QBKBOOKS/BOOKS folder on the AS/400. Therefore, the PC drive letter
should be assigned to QBKBOOKS. For example, if drive j is assigned to
QBKBOOKS on AS/400, the destination path for installing the collection using
SCRT would be j:\books.

Copying IBM Books to an AS/400 System Directory
The following examples assume D is the drive letter for the CD-ROM drive, \BOOKS
is the directory containing the books on the CD-ROM, I is the drive letter assigned
to the AS/400 System, and \QBKBOOKS\BOOKS is the directory to contain the Client
Access for OS/400 books on the AS/400 System.

Note: The QBKBOOKS/BOOKS directory is created when OS/400 is installed. It is the
default directory for online books.

The examples also assume you are copying the Client Access for OS/400 bookshelf
and books. The file names for most Client Access for OS/400 books and its
bookshelf begin with the letters QBKAK (V3R1) or QBJAK (V3R6). If you want to use
different books or directories, substitute their names for the names used in the
examples.
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To copy IBM books and bookshelves from a CD-ROM to a Client Access for
OS/400 folder, follow these instructions:

1. Switch to the drive letter assigned to the AS/400 System. Type:

i:

2. Copy the books you want in the folder from the CD-ROM with the COPY or
XCOPY command. Type:
copy d:\books\qbkak*.boo i:\qbkbooks\books
copy d:\shelves\qbkak*.bks i:\qbkbooks\books
copy d:\books\qbkak*.bki i:\qbkbooks\books

You can also use the SCRT to install the books to the AS/400 System. Simply
specify the path to the AS/400 directory as the target for the SCRT.

Users can now access the books and bookshelves by assigning the directory drive
to their workstations and identifying that drive to the Softcopy Reader installation
program if they are installing the IBM Softcopy Reader on their workstations.

Users of InfoSeeker can also access the books once they are installed in the
directory. If the books are placed in a directory other than qbkbooks/books, you
must define the directory to InfoSeeker. Use the Work with System Value
(WRKSYSVAL) OS/400 control language command to specify the folder path in the
QBOOKPATH system value. The paths specified for QBOOKPATH (up to five
paths can be defined) must be of the form:
/QDLS/directory

to correctly access the collection in the directory. For example, the default value is:
/QDLS/QBKBOOKS/BOOKS

Installing Books on OS/400 Version 3 Release 6 or Later
To install books to an AS/400 System from the AS/400 CD-ROM drive, place the
CD-ROM in the drive. Enter:
rstshf *shelf shelf(*list) dev(optical-device) vol(volume-name)

on the AS/400 command line. optical-device is the name assigned to your CD-ROM
drive on the AS/400 System (normally opt01); volume-name is the internal identifier
of the CD-ROM platter. To determine the volume name, use the Work with Optical
Volume (WRKOPTVOL) OS/400 control language command.

A list of bookshelves is presented so you can select the ones you want to install.
You can also choose whether you want the books installed to the AS/400 System
(the bookshelves and bookshelf index files will be installed).

To access books directly from the CD-ROM, you must identify the CD-ROM
volume to InfoSeeker. Use the Work with System Value (WRKSYSVAL) OS/400
control language command to specify the folder path in the QBOOKPATH system
value.

To access books and bookshelves from the CD-ROM, you do not need to install
anything to the AS/400 System. Simply use the WRKSYSVAL command to identify
the BOOKS and SHELVES directories on the CD-ROM to InfoSeeker. The paths
specified for QBOOKPATH (up to five paths can be defined) must be of the form:
/QOPT/volume-name/directory
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to correctly access the CD-ROM. The QBOOKPATH system value can contain paths
to directories (QDLS) and the CD-ROM (QOPT).

For complete descriptions of these procedures, look in any of these softcopy
collections:
v AS/400 Softcopy Library and Information Directory CD-ROMs (V3R6), SK2T-2839
v AS/400 Softcopy Library and Information Directory CD-ROMs (V3R7), SK2T-8290
v AS/400 Information Center CD-ROM (V4), SK3T-2027
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Part 5. Appendixes
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Appendix A. Installing IBM Softcopy Collections on a LAN
Server

You can put IBM Softcopy Reader and IBM softcopy collections on a LAN. You
may want to put the collections of IBM books on a LAN because:
v You want to centralize control and support of the softcopy collections.
v You do not have CD-ROM or DVD drives for all your workstations.
v You do not have space on each workstation for Softcopy Reader and the books.

There are different ways to use the LAN server. You can:
v Put the CD-ROMs or DVDs containing the IBM softcopy collections on one or

more of the LAN server's CD-ROM or DVD drives, and put Softcopy Reader on
a LAN server hard disk.

v Put the CD-ROMs or DVDs on one or more of the LAN server's hard disks, and
put Softcopy Reader on a LAN server hard disk.

v Put the CD-ROMs or DVDs on one or more of the LAN server's CD-ROM or
DVD drives, and put Softcopy Reader on the hard disk in each workstation.
Putting Softcopy Reader on each workstation's hard disk may also improve
performance.

Planning for LAN Setup
To make IBM softcopy collections available to users on a LAN, you need to put the
books, shelves, and indexes, and IBM Softcopy Reader out on the drives of the
server and give users access to these drives. You can install the readers on each
individual workstation, or on a drive on the server. You can also define the readers
as public applications, so whenever a workstation is booted, icons for the readers
appear.

Your LAN setup must have the following:
v User access to the books, shelves, and indexes.
v User access to the Softcopy Reader code.
v BookManager pointing to the directory containing the books.

Users should see this setup automatically when they logon to the LAN.

You may want to consider attaching at least one CD-ROM or DVD drive for each
disc containing IBM books you want to use and additional drives for any other
discs you plan to use. Additional CD-ROM or DVD drives minimize the swapping
of discs at the server.

To improve user access to softcopy on a LAN server, you might want to copy some
of the tools or interfaces provided on softcopy collections.
v For information about the interface and executables for installing softcopy tools,

see “Installing Tools from a Network Drive” on page 24.
v For information about the interface to the softcopy collection index, see

Chapter 8, “Using the Softcopy Collection Index with a Softcopy Repository
(Windows Users Only),” on page 57.
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Appendix B. Setting Up a Walk-Up-and-Use Library Kiosk

You can set up a walk-up-and-use kiosk for your IBM softcopy collections. One
kiosk can serve your department or one or more can serve your entire
organization. You just need to place a terminal or workstation with access to the
softcopy collections in a location that is convenient for the members of your
organization to get to when they need information. If you are the administrator for
your company's hardcopy library, you may already have a kiosk that you use for
other kinds of library access. You may be able to add the IBM softcopy collections
to the terminal or workstation that you are already using as a kiosk. To set up a
kiosk, you can do the following:

1. Decide how the kiosk should be set up. You can do one of the following:

a. Set up a Windows or AIX/6000 workstation and the IBM softcopy
collections yourself in your department or library.

b. Work with your LAN administrator to set up a Windows or AIX/6000
LAN-connected workstation that has access to a LAN server containing the
IBM softcopy collections.

c. Work with your z/OS, z/VM, or VM system administrator to set up a
host-connected terminal or workstation that has access to a z/OS, z/VM, or
VM host that contains IBM softcopy collections. You may need to help your
administrator by uploading the contents of the softcopy collections to your
host system.

2. Use the collections at your workstation or give them to the LAN administrator
or your host system administrator. Do one of the following:
a. Use the collections in one or more CD-ROM or DVD drives attached to

your kiosk. You might want to put the drives in a secure place to prevent
users from switching discs without your knowing it.

b. Copy the books and IBM Softcopy Reader from the discs on a CD-ROM or
DVD drive attached to your kiosk onto a large hard disk in the kiosk.

c. If your kiosk does not have its own CD-ROM or DVD drive but is
connected to a host, you can upload the books and the Softcopy Reader
from the discs at a workstation that has a CD-ROM or DVD drive to your
host and then download them to your kiosk.

d. Upload the books from the discs at a workstation that has a CD-ROM or
DVD drive to your z/OS, z/VM, or VM host.

3. Provide instructions to your users so they can get access to the IBM softcopy
collections.

To improve user access to softcopy on a kiosk, you might want to copy some of
the tools or interfaces provided on softcopy collections.
v For information about the interface and executables for installing softcopy tools,

see “Installing Tools from a Network Drive” on page 24.
v For information about the interface to the softcopy collection index, see

Chapter 8, “Using the Softcopy Collection Index with a Softcopy Repository
(Windows Users Only),” on page 57.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Mail Station P300
2455 South Road
Poughkeepsie, NY 12601-5400
U.S.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Terms and Conditions for Items in the Online Library
Before using or copying books and programs on IBM softcopy collections, you
must first read and agree to the terms and conditions specified for them. If you do
not agree, return the collection to IBM. By using and copying the books or
programs, you agree to the terms and conditions and the license agreement.

Using and Copying Online Books
Unlicensed books have order numbers that begin with the letters G or S. The
terms and conditions for using and copying unlicensed books provided in softcopy
format (such as BookManager or PDF) are stated in a file called BOOKENG.AGR
on collections that contain these files. The file is in text format and can be
displayed or printed from your personal computer.

Licensed books have order numbers that begin with the letter L. These books are
classified “Licensed Materials—Property of IBM”. The terms and conditions for
using licensed books are stated in the Licensed Program Specifications for the product
to which they apply and in the IBM Customer Agreement.

Using and Distributing the IBM Softcopy Reader Program
The terms and conditions for using and distributing the IBM Softcopy Reader
program are stated in a file called PLALRENG.AGR included on IBM softcopy
collections that contain these programs. The file is in text format and can be
displayed or printed from your personal computer.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation, registered in many jurisdictions
worldwide. Other product and service names might be trademarks of IBM or other
companies. A current list of IBM trademarks is available on the Web at “Copyright
and trademark information” at http://www.ibm.com/legal/copytrade.shtml
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Adobe and PostScript are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States, and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, and/or
other countries

Microsoft, Windows, Windows NT, Windows 2000, Windows XP, Windows Vista,
Windows 7, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.
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